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1. Введение (пояснительная записка) 

Специальный курс «Инженерная компьютерная графика» изучается студентами 2 

курса, обучающихся по направлению 710100 «Информатика и ВТ», специализаций 

«Администрирование КС и телекоммуникации» и «Международные компьютерные сети  

и офисные системы». 

Курс предусматривает лекционные занятия, лабораторный практикум, а также 

самостоятельную работу студентов. По итогам изучения дисциплины студенты сдают 

экзамен. Текущий контроль и самоконтроль усвоения курса осуществляется посредством 

выполнения студентами лабораторных работ и сдачи модулей. 

 

2. Цели и задачи дисциплины, ее место в учебном процессе 

Цель изучения дисциплины заключается в развитии у студентов 

пространственного мышления для дальнейшего овладения общеинженерными и 

специальными техническими дисциплинами, дать знания и привить навыки 

выполнения и чтения изображений предметов. Задачи изучения дисциплины 

вытекают из требований к объему знаний и умений студентов. 

Целью дисциплины является овладение приемами работы в 

профессиональном графическом редакторе растровых изображений Adobe Photoshop. 

Целью дисциплины является обучение студентов созданию графических 

документов на персональных компьютерах знакомство с графическим редактором 

Adobe Photoshop.  

Данный курс тесно связан с базовыми знаниями информатики. Кроме того, в 

ходе изучения данной дисциплины, студент получает базовые знания в области 

компьютерной графики,  что является необходимым для продолжения обучения в 

данном направлении и в будущем в его профессиональной деятельности. 

Данный курс позволяет студентам освоить на теоретическом и практическом 

уровне основные приемы и методы работы с компьютерной графикой, которое 

является сейчас в наше время наиболее востребованными в области компьютерной 

графики. 

Изучение данной дисциплины позволит студентам адаптироваться в 

современных графических пакетах, и освоить основные приемы и принципы работы в 

них. 

2.1. Целью изучения курса «Инженерная компьютерная графика» является 

знакомство с основными концепциями, технологиями и тенденциями развития 

компьютерной графики, а также освоение основных графических пакетов применяемых 

при создании иллюстраций. 

2.2 Основными задачами курса являются: 

- знакомство с основами построения и функционирования графических пакетов; 

- знакомство с технологиями построения графических иллюстрация; 

- знакомство с основными проблемами и тенденциями развития компьютерной 

графики. 

- овладение навыками Adobe Photoshop 

2.3 В результате изучения курса студент будет : 

В результате освоения дисциплины обучающийся должен демонстрировать 

следующие 

результаты образования: 

1) знать 

- основные принципы работы графических устройств; 
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- современные графические пакеты; 

- методы построения эскизов, чертежей и технических рисунков стандартных 

деталей, разъемных и неразъемных соединений; 

- построение и чтение сборочных чертежей общего вида различного уровня 

сложности и назначения; 

- тенденции развития компьютерной графики, ее роль и значение в инженерных 

системах и прикладных программах. 

2) уметь 

- пользоваться инструментальными программными средствами интерактивных 

графических систем, актуальных для современного производства; 

- представлять технические решения с использованием средств компьютерной 

графики и геометрического моделирования. 

3) Владеть навыками: 

- работы с учебной, справочной и другой технической литературой; 

- пользования средствами компьютерной графики. 

- работы в профессиональном пакете Adobe Photoshop; 

- основными концепциями работы векторной и растровой графики; 

- методами и средствами разработки и оформления технической документации. 

В процессе освоения данной дисциплины студент формирует и демонстрирует 

следующие общекультурные компетенции: 

- способен к обобщению, анализу, восприятию информации, постановке цели и 

выбору путей её достижения, владеет культурой мышления, (ОК–1); 

- способен логически верно, аргументировано и ясно строить устную и письменную 

речь (ОК-2); 

- способен к кооперации с коллегами, работе в коллективе (ОК-3); 

- способен применять основные методы, способы и средства получения, хранения, 

переработки информации, навыки работы с компьютером как средством 

управления информацией (ОК-17); 

- способен работать с информацией в глобальных компьютерных сетях (ОК-18); 

профессиональные компетенции: 

- способен использовать современные информационные технологии при 

проектировании изделий, производств (ПК-10); 

- способен разрабатывать проектную и рабочую техническую документацию в 

области автоматизации технологических процессов и производств, управления 

жизненным циклом продукции и ее качеством, оформлять законченные проектно-

конструкторские работы (ПК-13); 

- способен участвовать в мероприятиях по контролю соответствия разрабатываемых 

проектов и технической документации действующим стандартам, техническим 

условиям и другим нормативным документам (ПК-14). 

 

2.4 Перечень дисциплин, усвоение которых студентам необходимо для изучения 

данной дисциплины. 

Курсы государственного компонента ГОС (математика и информатика). 

2.5 Сфера применения результатов изучения дисциплины чрезвычайно широка – 

любые знания, полученные в ходе изучения дисциплины должны помочь студентам в их 
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дальнейшей профессиональной деятельности по созданию, внедрению и эксплуатации 

современных графических пакетов. 
 

3. Методы изучения дисциплины 

Изучение данной дисциплины предполагает проведение: 

 лекционных занятий в объеме 1 кредит  

 практических занятий в компьютерном классе в объеме 3 кредитов 

 проведение письменных и практических контрольных работ в конце каждого 

модуля. 

 самостоятельная работа студентов. 
 

4. Материально-техническое обеспечение изучения дисциплины 

Занятия по дисциплине «Разработка клиент-серверных приложений» проводятся в 

лекционных залах и компьютерных классах на компьютерах типа Pentium. 

5. Объем и содержание занятий 

Структура дисциплины: 
 

Модуль Наименование 

1. 
Графические пакеты. Современные графические 

системы. Photoshop. 

2. 
Типы компьютерных изображений. Технические 
средства компьютерной графики. 

3. 
Цветовые модели и их виды. Понятие цвета и его 

характеристики. 

4 Форматы хранения графической информации. 
 

 6. График поведения модулей.  

I модуль (4-я неделя) –решение практических заданий на компьютере.  

I I модуль (8-я неделя) –решение практических заданий на компьютере. 

I I I модуль (12-я неделя) –решение практических заданий на компьютере. 

I V модуль (16-я неделя) –решение практических заданий на компьютере. 

 

7 . Модульно-рейтинговая аттестация студентов.  

 МОДУЛЬ I   Графические пакеты. Современные графические системы. Photoshop. 

КОЛИЧЕСТВО НЕДЕЛЬ 4 
 Модуль 1. Включает в себя: 

- Лекционные занятия в объеме 4 часов. 

- Лабораторные занятия в объеме 12 часов 

- Самостоятельная работа студентов с преподавателем в объеме 4,5 часов 

- Самостоятельная работа студентов без преподавателя в объеме 9,5 часов 

Сдача модуля организуется в виде практической работы на компьютере. 

Лекции 

1. Введение. Области применения компьютерной графики. 

2. Классификация графических пакетов. 

3. Технология создания и обработки графической информации.  

4. Типы компьютерных изображений. Векторные изображения. 

Лабораторные работы 

1. Типы компьютерных изображений. Растровые изображения. Понятие – 

разрешение. 

2. Тенденции построения современных графических систем. 

3. Технические средства компьютерной графики: мониторы, графические 

адаптеры, плоттеры, принтеры, сканеры. 

4. Понятие цвета и его характеристики. Цвет в компьютерной графике 
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основные понятия. 

Самостоятельная работа студентов с преподавателем 

Элементы, организация и настройка, навигация. Создание нового 

изображения. Работа с основными параметрами изображения. 

Самостоятельная работа студентов без преподавателя 

Программы Photoshop. Работа с текстом. Работа с основными 

инструментами Photoshop. 

Вопросы к модулю 1. 

1. Векторное и растровое изображения. Недостатки. 

2. Режимы рисования. 

3. Классификация графических пакетов. 

4. Типы компьютерных изображений. 

5. Растровые изображения. 

6. Понятие – разрешение. 

7. Основные параметры изображения. 
 МОДУЛЬ II Типы компьютерных изображений. Технические средства 

компьютерной графики.  

КОЛИЧЕСТВО НЕДЕЛЬ 4 

 

 Модуль 2. Включает в себя: 

-Лекционные занятия в объеме 4 часов. 

- Лабораторные занятия в объеме 12 часов 

- Самостоятельная работа студентов с преподавателем в объеме 4,5 часов 

- Самостоятельная работа студентов без преподавателя в объеме 9,5 часов 

Сдача модуля организуется в виде практической работы на компьютере. 

Лекции 

1. Типы компьютерных изображений. Растровые изображения. Понятие – 

разрешение. 

2. Тенденции построения современных графических систем. 

3. Технические средства компьютерной графики: мониторы, графические 

адаптеры, плоттеры, принтеры, сканеры. 

4. Понятие цвета и его характеристики. Цвет в компьютерной графике 

основные понятия. 

Лабораторные работы 

1. Каналы. Использование каналов для создания изображений. 

2. Исследование характеристик фильтров программы Photoshop. 

3. Работа с текстом. “Отбрасываем тень”, “Рельефный текст”, “ Плавающие 

объекты”, Плавная граница изображения. 

4. Создаем конус, Создаем 3D шар, Пишем по окружности. 

Самостоятельная работа студентов с преподавателем 

Работа с фильтрами. Слои. Работа со стилями слоя. Создание слоя. 

Частичное совмещение. 

Самостоятельная работа студентов без преподавателя 

“Эффект Х-files”, “Эффект воды”, “Создаем водяную поверхность”, 

Футуристичные точки, Эффект ледяной надписи. “Ржавый текст”, 

“Раскрошенный текст”, Эффект незавершенного произведения, Эффект 

штампа. 

Вопросы к модулю II 

1. Понятие цвета и его характеристики. 

2. Цвет в компьютерной графике. 

3. Цветовые модели и их виды. 

4. Классификация цветовых моделей. 

5. Характеристики света 
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6. Способы регулировки цвета. 

7. Образцы фонового и рабочего цветов. 
 МОДУЛЬ III Цветовые модели и их виды. Понятие цвета и его характеристики. 

КОЛИЧЕСТВО НЕДЕЛЬ 4 

 

 Модуль 3. Включает в себя: 

- Лекционные занятия в объеме 4 часов. 

- Лабораторные занятия в объеме 12 часов 

- Самостоятельная работа студентов с преподавателем в объеме 4,5 часов 

- Самостоятельная работа студентов без преподавателя в объеме 9,5 часов 

Сдача модуля организуется в виде практической работы на компьютере. 

 

Лекции 

1. Законы смешивания цветов. Цветовой режим. Базовые цвета. 

2. Цветовые модели и их виды. Классификация цветовых моделей. 

3. Цветовая модель RGB, HSB. 

4. Цветовая модель CMY, CMYK, Lab. 

Лабораторные работы 

1. Футуристический эффект I, Футуристический эффект II. “Кубический 

текст”, “Эффект электрического разряда”. 

2. Работа с фильтрами. “Эффект Х-files”, “Эффект воды”, “Создаем водяную 

поверхность”. 

3. Работа с фильтрами. Футуристичные точки, Частичное совмещение, Эффект 

ледяной надписи. 

4. “Ржавый текст”, “Раскрошенный текст”, Эффект незавершенного 

произведения, Эффект штампа. 

Самостоятельная работа студентов с преподавателем 

Каналы. Использование каналов для создания изображений. 

Самостоятельная работа студентов без преподавателя 

Футуристичные точки. Частичное совмещение. Эффект ледяной надписи. 

“Ржавый текст”. “Раскрошенный текст”. Эффект незавершенного 

произведения. Эффект штампа. 

Вопросы к модулю III 

1. Палитры. 

2. Форматы хранения графической информации. 

3. Растровые графические форматы. 

4. Векторные графические форматы. 

5. Способы соединения фотореалистических изображений. 

6. Принципы работы векторного редактора. 

 

 МОДУЛЬ IV  Форматы хранения графической информации.  

КОЛИЧЕСТВО НЕДЕЛЬ 4 
 Модуль 4. Включает в себя: 

-Лекционные занятия в объеме 8 часов. 

- Лабораторные занятия в объеме 16 часов 

- Самостоятельная работа студентов с преподавателем в объеме 4,5 часов 

- Самостоятельная работа студентов без преподавателя в объеме 9,5 часов 

Сдача модуля организуется в виде контрольной работы. 

 

Лекции 

1. Палитры. Маски. Контуры. Каналы. 

2. Форматы хранения графической информации. 

3. Растровые графические форматы. 

4. Векторные графические форматы. 
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Лабораторные работы 

1. Работа с фигурами. 3D - эффекты. 

2. Создание композиции разных рисунков (коллаж). 

3. Создание макета для WEB страницы. Подготовка макета к верстке. 

4. Создание макета для WEB страницы. Подготовка макета к верстке. 

Самостоятельная работа студентов с преподавателем 

Создание макета для WEB страницы. Подготовка макета к верстке. 

Самостоятельная работа студентов без преподавателя 

Рисование простейших фигур. Выделение изображения. Ввод и 

редактирование текста. 

Вопросы к модулю III 

1. Векторные изображения. 

2. Законы смешивания цветов. 

3. Маски 

4. Контуры. Каналы. 

5. Тенденции построения современных графических систем. 

6. Технические средства компьютерной графики. 
 

 

8. Учебная  деятельность 

Деятельность студента при изучении дисциплины заключается: 

- в восприятии и усвоении материала дисциплины, излагаемого на лекционных 

занятиях, 

- в самостоятельном изучении материала по литературе и электронным источникам 

информации, 

- в подготовке к выполнению лабораторных работ, 

- в отчетности по результатам лабораторной работы и учебному материалу, связанному 

с её  содержанием, 

- обязательной сдаче всех модулей по данному курсу 

 

 

9. Требования об академической успеваемости: 

 

 Успешность изучения дисциплины в системе кредитных технологий оценивается 

суммой набранных баллов (из 100 возможных): 

Распределение баллов распределяется следующим образом: 

Отлично (85%-100%) 

Хорошо  (70%-84%) 

Удовлетворительно (55%-69%) 

Неудовлетворительно (0%-54%) 
 

Весь материал курса разбивается на смысловые модули, в зависимости от объема 

дисциплины. (1 кредитная дисциплина – 1 модуль, 2 кредитная дисциплина – 2 модуля, 3 

кредитная дисциплина – 3 модуля, 4-х, 5-ти  кредитная дисциплина – 4 модуля).  

 

За сдачу каждого модуля студент максимально может получить 100 баллов. 

По результатам прохождения модуля оценка знаний студента  формируется 

следующим образом: 

1. Текущий контроль (0-25) баллов. 

- Активность на занятиях – 5 баллов    
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- Посещение занятий студентами -5 баллов   

- Систематичность подготовки студентов к занятиям -5 баллов    

- Поощрение студентов за самостоятельное  усвоение материалов-5 баллов 

- Системность и регулярность работы студентов с учебной и научной литературой 

 -5 баллов 

2. Рубежный контроль (0-75 баллов) 

- СРСП (30 баллов) 

- СРС (30 баллов) 

- Модульно-рейтинговый контроль (тесты, контрольные работы, устный опрос) 

(15 баллов). 

3. Итоговая  аттестация 

Для итоговой аттестации студента на «зачет»: 

Вычисляется средний балл, набранный студентом, по результатам сдачи всех модулей  

 

Бср=∑Бn/n 

Бср - средний балл 

∑Бn - сумма баллов за каждый 

модуль 

n-количество всех модулей 

 

Если средний балл выше или равен  75 баллам, то преподаватель имеет право 

поставить зачет автоматически. 

 

Для итоговой аттестации студента на «экзамен»: 

Вычисляется средний балл, набранный студентом, по результатам сдачи всех модулей  

Бср=(∑Бn/n)*0.6 

Бср - средний балл 

∑Бn - сумма баллов за каждый 

модуль 

n-количество всех модулей 

0.6 – 60% от общей оценки 

 

Студенты, получившие по итоговым результатам сдачи модулей менее 15 баллов, 

на экзамен не допускаются.  

На итоговой аттестации студент максимально может набрать (0-40) баллов. 

Таким образом, общая оценка складывается из суммы баллов полученных  за сдачу  всех 

модулей и баллов полученных на итоговой аттестации. Набранные баллы в соответствии 

с выше указанной таблицей переводятся в пятибалльную систему и проставляется в 

итоговую экзаменационную ведомость.  

Примечание: 

По желанию преподавателя студенты, набравшие итоговую оценку по результатам 

модулей (без поправочного коэффициента 0.6) 85-100 баллов могут получить оценку за 

экзамен «отлично»- автоматически.  
 

10. Рекомендуемая литература 

1. Романычева Э.Т., Яцюк О.Г. Дизайн и реклама. Компьютерные 

технологии. -М.:ДМК, 2000.-432 с. 

2. Коорабельников Г., Гурский Ю. Adobe Photoshop в теории и на практике. 

Мн. Новое знание, 2002г. - 528с. 
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3. Гурский Ю., Васильев А. Трюки и эффекты Photoshop CS - СПб.: Питер, 

2004. — 555с. 

4. Карасева Э. В., Чумаченко И. Н. Рисованиев Photoshop CS —М: 

ООО «Издательство ACT: Издательство НТ Пресс ,2004. — 218, 

[6] с. 

5. Григорян М. Photoshop: от простого к сложному. Часть 91: ЗБ-эффект в 

Photoshop 2005. 

11.Задания к самостоятельной работе студентов.  

МОДУЛЬ 1 

МОДУЛЬ 1 

Тема   1: 

ИНСТРУМЕНТ ОБЛАСТЬ 
 

 

 

 

Работа с областями 

Для выделения области используют  

инструменты 

 

  

 

Выделенную область можно перемещать 

ИНСТРУМЕНТ ПЕРЕМЕЩЕНИЕ 

копировать в буфер обмена,  

Редактироварть/копировать 

вставлять из буфера, 

Редактироварть/вклеить 

в новый рисунок 

Изменять размер, наклон 

Редактирование- 

Свободное трансформирование 

  

 

 

 

 

 

 

 

 

 

 

 

 

Задание. 

Используя исходные графические 

Файлы  папки «Работа с областями»  

 

Создайте изображения.  
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МОДУЛЬ 2 

 

СЛОИ 
1. Создай новый файл Файл/Новый 

2. Задай размер  ширина 15 см,     высота 20 см 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Открой файл «Создай домовёнка». 

 

 

 

 

3. Скопируй нужные фрагменты в новыё файл, 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Объект расположенный на слое можно уменьшать, увеличивать, изменять наклон. 

Редактирование/ Свободное трансформирование. 

Для создания второго валенка, сапога, перчатки.. 

Примените  

Редактирование/Трансформирование/отразить по вертикали 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Для того, чтобы объект частично спрятать за другой, переместите его слой ниже.  

В данном случае надо слой с валенком перетащить за слой со штаниной (поместить между 

слой 3 и слой 1)  

Панель «Слои» - Окно/Слои F7 

 

При копировании каждый новый фрагмент 

встаёт в новый слой. 

 

 

 

Текущий слой, (тот в котором  ты 

работаешь), проверить можно закрыв глазик 

– изображение спрячется. 
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СОБЕРИ своего ДОМОВЁНКА, например: 
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МОДУЛЬ 3 
ГРАДИЕНТ 

 

Создайте новый файл 

1. Файл/Новый 

размером 15 на 20 см 

 

 

 

 

 

2. Выделите прямоугольную область.  

 

 

                                     Возьмите инструмент заливка/градиент, выберите тип градиента, 

                                                                         укажите направление перетекания градиента 

 

 

 

 

 

                                                                                   

 

 

 

 

 

 

 

 

 

ПОТРЕНИРУЙТЕСЬ, создайте овальную область,  

произвольную область. 

 
Используя изображения из папки «Колбаса» создайте 

композицию «Голодный кот». 
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МОДУЛЬ 4 
Стеклянная кнопка 

1. Откройте приложение Adobe Photoshop 

2. Откройте любое исходное изображение, например tiger.tif 

 

 
3. Создайте круглое выделение. 

4. Инвертируйте выделение. 

5. Залейте выделение белым цветом. 

 

 
6. Снова инвертируйте выделение. 

7. Создайте новый слой. 

8. Установите цвета фона и переднего плана чёрный и белый. 

 

 
9. Создайте градиентную заливку в выделенной области при помощи Радиального градиента. 

 

 

10. В параметрах слоя установите режим . 

 

 
11. Придайте объем при помощи эффектов слоя Фаска и рельеф и Внутренние тени. 

 

 
12. Склейте слои. Готовое изображение сохраните в своей папке. 

  

http://www.modern-computer.ru/media/source_pictures/tiger.zip
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 Раздел 2. Силлабус (Syllabus) 

 

Курс ««Разработка клиент-серверных приложений» (4- кр.ч.) 
                        
Преподаватель: 

Ф.И.О. Долгоульский О.В. 
 

 

ст. преподаватель  
«Компьютерные информационные 
системы и управление»  
                                                 
 

тел. рабочий:  _613962____ 

ПК МУК, г. Бишкек, Кыргызстан                                             офис: ауд. 58 
 

День, время и место занятий:  

по расписанию 

Расписание приема студентов во 

внеклассное время: вторник  11.00 ауд.58                                                                                                                     

 
                                                                          
Пререквизиты курса:.  

 

Для освоения данной дисциплины 

необходимо пройти следующие курсы: 

СПО, ППО. 

 

Постреквизиты курса:  

 

В результате изучения дисциплины 

студенты владеют основными 

принципами работы графических 

устройств, осваивают основные 

концепции работы векторной и 

растровой графики, получают навыки 

работы в профессиональном 

графическом редакторе растровых 

изображений Adobe Photoshop. 

 

Целевая аудитория:                                                                 Студенты специальности: 

«Администрирование КС и 

телекоммуникации» 

««Информационные системы и 

технологии»» 

 

 

Краткое описание курса: 

Изучение данного курса  позволяет студентам понять идеологию создания 

растровых и векторных изображений с применением современных графических 

редакторов.  

 

Цели предлагаемого курса: 

Целью дисциплины является овладение приемами работы в 

профессиональном графическом редакторе растровых изображений Adobe Photoshop.  

 

Правила поведения в классе: Согласно Общему положению МУК, преподаватель 

ожидает, что:  студенты не опаздывают на занятия, не пропускают занятия без 

уважительной причины, отрабатывают пропущенные занятия по согласованию с 

преподавателем. Во время занятий нельзя разговаривать, пользоваться сотовыми 

телефонами, покидать аудиторию, слушать музыку, жевать резинку, кушать, читать 

газеты и журналы… 



15 

 

 

Политика академического поведения и этики: Быть толерантным, уважать мнение 

окружающих. Возражения формулировать в корректной форме. Плагиат и другие формы 

нечестной работы недопустимы. К плагиату относится следующее: отсутствие ссылок 

при использовании печатных и электронных материалов, цитат, мыслей других авторов. 

Недопустимы подсказывание и списывание во время тестов, экзаменов, занятий; сдача 

экзамена за другого студента, неразрешенное копирование материалов.  В случае 

нарушения одного из вышеперечисленных пунктов студент не аттестовывается по курсу. 

 

Требования к студенту при изучении курса: прочитать необходимую литературу, 

выполнить весь комплекс практических работ, посетить все занятия, своевременно сдать 

все модули. 

Виды занятий и работ студента:  

 Лекции 

 Самостоятельная работа студентов под руководством преподавателя 

 Самостоятельная работа студентов 

 Выполнение практических заданий 

 Написание рефератов 

 Бланочное и компьютерное тестирование 
Итоговый контроль:  экзамен 
Успешность изучения дисциплины в системе кредитных технологий оценивается суммой 

набранных баллов (из 100 возможных): 

Распределение баллов распределяется следующим образом: 

Отлично (85%-100%) 

Хорошо  (70%-84%) 

Удовлетворительно (55%-69%) 

Неудовлетворительно (0%-54%) 
 

Весь материал курса разбивается на смысловые модули, в зависимости от объема 

дисциплины. (1 кредитная дисциплина – 1 модуль, 2 кредитная дисциплина – 2 модуля, 3 

кредитная дисциплина – 3 модуля, 4-х, 5-ти  кредитная дисциплина – 4 модуля).  

 

За сдачу каждого модуля студент максимально может получить 100 баллов. 

По результатам прохождения модуля оценка знаний студента  формируется 

следующим образом: 

3. Текущий контроль (0-25) баллов. 

- Активность на занятиях – 5 баллов    

- Посещение занятий студентами -5 баллов   

- Систематичность подготовки студентов к занятиям -5 баллов    

- Поощрение студентов за самостоятельное  усвоение материалов-5 баллов 

- Системность и регулярность работы студентов с учебной и научной литературой 

 -5 баллов 

4. Рубежный контроль (0-75 баллов) 

- СРСП (30 баллов) 

- СРС (30 баллов) 

- Модульно-рейтинговый контроль (тесты, контрольные работы, устный опрос) 

(15 баллов). 

3. Итоговая  аттестация 

Для итоговой аттестации студента на «зачет»: 

Вычисляется средний балл, набранный студентом, по результатам сдачи всех модулей  
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Бср=∑Бn/n 

Бср - средний балл 

∑Бn - сумма баллов за каждый 

модуль 

n-количество всех модулей 

 

Если средний балл выше или равен  75 баллам, то преподаватель имеет право 

поставить зачет автоматически. 

В течение одного-трех следующих после рейтингового контроля дней обучающиеся 

имеют право на  апелляцию. Заявление на апелляцию подается лично обучающимися на 

имя декана и рассматриваются предметной апелляционной комиссией кафедры. 

 

ВНИМАНИЕ: Прохождение всех видов контроля является обязательным для всех 

студентов. 

 

 Модульно-рейтинговая аттестация студентов. 

Модуль Наименование 

1. 
Язык HTML, Операторы PHP, математические 

функции 

2. Функции для работы с массивами   

3. Работа с файлами.  

4 Работа с БД 
 

 6. График поведения модулей.  

I модуль (4-я неделя) –решение практических заданий на компьютере.  

I I модуль (8-я неделя) –решение практических заданий на компьютере. 

I I I модуль (12-я неделя) –решение практических заданий на компьютере. 

I V модуль (16-я неделя) –решение практических заданий на компьютере. 

 

 

7 . Модульно-рейтинговая аттестация студентов.  

 МОДУЛЬ I   Графические пакеты. Современные графические системы. Photoshop. 

КОЛИЧЕСТВО НЕДЕЛЬ 4 
 Модуль 1. Включает в себя: 

- Лекционные занятия в объеме 4 часов. 

- Лабораторные занятия в объеме 12 часов 

- Самостоятельная работа студентов с преподавателем в объеме 4,5 часов 

- Самостоятельная работа студентов без преподавателя в объеме 9,5 часов 

Сдача модуля организуется в виде практической работы на компьютере. 

Лекции 

5. Введение. Области применения компьютерной графики. 

6. Классификация графических пакетов. 

7. Технология создания и обработки графической информации.  

8. Типы компьютерных изображений. Векторные изображения. 

Лабораторные работы 

5. Типы компьютерных изображений. Растровые изображения. Понятие – 

разрешение. 

6. Тенденции построения современных графических систем. 

7. Технические средства компьютерной графики: мониторы, графические 
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адаптеры, плоттеры, принтеры, сканеры. 

8. Понятие цвета и его характеристики. Цвет в компьютерной графике 

основные понятия. 

Самостоятельная работа студентов с преподавателем 

Элементы, организация и настройка, навигация. Создание нового 

изображения. Работа с основными параметрами изображения. 

Самостоятельная работа студентов без преподавателя 

Программы Photoshop. Работа с текстом. Работа с основными 

инструментами Photoshop. 

Вопросы к модулю 1. 

8. Векторное и растровое изображения. Недостатки. 

9. Режимы рисования. 

10. Классификация графических пакетов. 

11. Типы компьютерных изображений. 

12. Растровые изображения. 

13. Понятие – разрешение. 

14. Основные параметры изображения. 
 МОДУЛЬ II Типы компьютерных изображений. Технические средства 

компьютерной графики.  

КОЛИЧЕСТВО НЕДЕЛЬ 4 

 

 Модуль 2. Включает в себя: 

-Лекционные занятия в объеме 4 часов. 

- Лабораторные занятия в объеме 12 часов 

- Самостоятельная работа студентов с преподавателем в объеме 4,5 часов 

- Самостоятельная работа студентов без преподавателя в объеме 9,5 часов 

Сдача модуля организуется в виде практической работы на компьютере. 

Лекции 

5. Типы компьютерных изображений. Растровые изображения. Понятие – 

разрешение. 

6. Тенденции построения современных графических систем. 

7. Технические средства компьютерной графики: мониторы, графические 

адаптеры, плоттеры, принтеры, сканеры. 

8. Понятие цвета и его характеристики. Цвет в компьютерной графике 

основные понятия. 

Лабораторные работы 

5. Каналы. Использование каналов для создания изображений. 

6. Исследование характеристик фильтров программы Photoshop. 

7. Работа с текстом. “Отбрасываем тень”, “Рельефный текст”, “ Плавающие 

объекты”, Плавная граница изображения. 

8. Создаем конус, Создаем 3D шар, Пишем по окружности. 

Самостоятельная работа студентов с преподавателем 

Работа с фильтрами. Слои. Работа со стилями слоя. Создание слоя. 

Частичное совмещение. 

Самостоятельная работа студентов без преподавателя 

“Эффект Х-files”, “Эффект воды”, “Создаем водяную поверхность”, 

Футуристичные точки, Эффект ледяной надписи. “Ржавый текст”, 

“Раскрошенный текст”, Эффект незавершенного произведения, Эффект 

штампа. 

Вопросы к модулю II 

8. Понятие цвета и его характеристики. 

9. Цвет в компьютерной графике. 

10. Цветовые модели и их виды. 
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11. Классификация цветовых моделей. 

12. Характеристики света 

13. Способы регулировки цвета. 

14. Образцы фонового и рабочего цветов. 
 МОДУЛЬ III Цветовые модели и их виды. Понятие цвета и его характеристики. 

КОЛИЧЕСТВО НЕДЕЛЬ 4 

 

 Модуль 3. Включает в себя: 

- Лекционные занятия в объеме 4 часов. 

- Лабораторные занятия в объеме 12 часов 

- Самостоятельная работа студентов с преподавателем в объеме 4,5 часов 

- Самостоятельная работа студентов без преподавателя в объеме 9,5 часов 

Сдача модуля организуется в виде практической работы на компьютере. 

 

Лекции 

5. Законы смешивания цветов. Цветовой режим. Базовые цвета. 

6. Цветовые модели и их виды. Классификация цветовых моделей. 

7. Цветовая модель RGB, HSB. 

8. Цветовая модель CMY, CMYK, Lab. 

Лабораторные работы 

5. Футуристический эффект I, Футуристический эффект II. “Кубический 

текст”, “Эффект электрического разряда”. 

6. Работа с фильтрами. “Эффект Х-files”, “Эффект воды”, “Создаем водяную 

поверхность”. 

7. Работа с фильтрами. Футуристичные точки, Частичное совмещение, Эффект 

ледяной надписи. 

8. “Ржавый текст”, “Раскрошенный текст”, Эффект незавершенного 

произведения, Эффект штампа. 

Самостоятельная работа студентов с преподавателем 

Каналы. Использование каналов для создания изображений. 

Самостоятельная работа студентов без преподавателя 

Футуристичные точки. Частичное совмещение. Эффект ледяной надписи. 

“Ржавый текст”. “Раскрошенный текст”. Эффект незавершенного 

произведения. Эффект штампа. 

Вопросы к модулю III 

7. Палитры. 

8. Форматы хранения графической информации. 

9. Растровые графические форматы. 

10. Векторные графические форматы. 

11. Способы соединения фотореалистических изображений. 

12. Принципы работы векторного редактора. 

 

 МОДУЛЬ IV  Форматы хранения графической информации.  

КОЛИЧЕСТВО НЕДЕЛЬ 4 
 Модуль 4. Включает в себя: 

-Лекционные занятия в объеме 8 часов. 

- Лабораторные занятия в объеме 16 часов 

- Самостоятельная работа студентов с преподавателем в объеме 4,5 часов 

- Самостоятельная работа студентов без преподавателя в объеме 9,5 часов 

Сдача модуля организуется в виде контрольной работы. 

 

Лекции 

5. Палитры. Маски. Контуры. Каналы. 

6. Форматы хранения графической информации. 
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7. Растровые графические форматы. 

8. Векторные графические форматы. 

Лабораторные работы 

5. Работа с фигурами. 3D - эффекты. 

6. Создание композиции разных рисунков (коллаж). 

7. Создание макета для WEB страницы. Подготовка макета к верстке. 

8. Создание макета для WEB страницы. Подготовка макета к верстке. 

Самостоятельная работа студентов с преподавателем 

Создание макета для WEB страницы. Подготовка макета к верстке. 

Самостоятельная работа студентов без преподавателя 

Рисование простейших фигур. Выделение изображения. Ввод и 

редактирование текста. 

Вопросы к модулю III 

7. Векторные изображения. 

8. Законы смешивания цветов. 

9. Маски 

10. Контуры. Каналы. 

11. Тенденции построения современных графических систем. 

12. Технические средства компьютерной графики. 

 

Модуль 1.  

Контрольные вопросы: 

1. Векторное и растровое изображения. Недостатки. 

2. Режимы рисования. 

3. Классификация графических пакетов. 

4. Типы компьютерных изображений. 

5. Растровые изображения. 

6. Понятие – разрешение. 

7. Основные параметры изображения. 

 

Модуль 2.  

Контрольные вопросы: 

1. Понятие цвета и его характеристики. 

2. Цвет в компьютерной графике. 

3. Цветовые модели и их виды. 

4. Классификация цветовых моделей. 

5. Характеристики света 

6. Способы регулировки цвета. 

7. Образцы фонового и рабочего цветов. 

 

Модуль 3. 

Контрольные вопросы: 

1. Палитры. 

2. Форматы хранения графической информации. 

3. Растровые графические форматы. 

4. Векторные графические форматы. 

5. Способы соединения фотореалистических изображений. 

6. Принципы работы векторного редактора. 

 

Модуль 4.  

Контрольные вопросы: 

1. Векторные изображения. 
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2. Законы смешивания цветов. 

3. Маски 

4. Контуры. Каналы. 

5. Тенденции построения современных графических систем. 

6. Технические средства компьютерной графики. 

 

Темы рефератов. 

 

1. Цветовые модели. 

2. Графические форматы. 

3. Методы и алгоритмы сжатия изображения. 

 

 

График проведения модулей. 

Неделя 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 

Лекция 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

Лаборатор

ные 

занятия 

3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 

 

 

 

 

Обязательные литература и место их поиска: См. рабочую программу 

Самостоятельная  работа студента: См. рабочую программу, учебно-методическое 

пособие 
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Раздел 3. Глоссарий 

Аддитивные цвета 
Большинство цветов видимого спектра могут быть получены путем смешивания в 

различных пропорциях трех основных компонент окрашенного света. Этими 

компонентами, которые называются первичными цветами, являются красный, зеленый и 

синий цвета. При смешивании первичных цветов образуются вторичные цвета: голубой, 

пурпурный и желтый.  

Первичные цвета называются также аддитивными, поскольку в результате их 

объединения (сложения) получается белый цвет - это означает, что свет полностью 

отражается и попадает обратно в глаз человека. Аддитивные цвета используются в 

системах освещения, в видеосистемах, в устройствах записи на фотопленку и в 

мониторах. Например, ваш монитор создает цвета, пропуская излучаемый свет через 

красный, зеленый и синий люминофор. 

Альфа-канал (Alpha channel) 
Дополнительный канал с восмибитным представлением изображения.Используется для 

создания и хранеия масок, на печать не выводится. 

Байт 
Единица информации, равная 8 битам. Является единицей измерения обьема оперативной 

памяти, дискового пространства, размеров файлов. 

Бит (Bit) 
Двоичный знак, "0" или "1", используемый в вычислительной технике для 

внутримашинного представления информации. В компьютерной графике служит в 

качестве единицы глубины цвета. 1 битом на пиксел  кодируется штриховое черно-белое 

изображение, 8 битами на пиксель - индексированнные цвета или градации серого, 24 

битами на пиксел можно закодировать 16,7 млн оттенков цвета. 

Битовая карта (Bitmap) 
Таблица цифровых значений, кодирующих цвет каждого пиксела изображения. Обыччно 

служит обознаачением черно- белого штрихового изображения. 

Векторная графика 
Способ предоставления графической информации с помощью совокупных 

кривых,описываемых математическими формулами. Этот способ обеспечивает 

возможность трансформаций изображений без потери качества. 

Выделение (Selction) 
Операция маркировки совокупности пикселов для перемещения, трансформации и т.д. 

Выполняется с помощью специальных инструментов и команд. 

Выделение цветной краски (UCR) 
Метод в цветоделении, при котором темные цветные части изображения заменяются на 

чернуюа краску. 

Гамма 
Коээфициент контраста в средних тонах изображения. 

Генерация черного 
Определение количества краски, приходящееся на черную плашку при цветодеоении. 

Гистограмма 
Графическое представление распределения уровней яркости в изображении. С помощью 

гистограммы вы также можете определить, содержит ли изображение достаточное 

количество деталей яркости, которое обеспечило бы хорошие результаты настройки: 

слишком малое количество полутонов может не позволить вам выполнить качественную 

коррекцию.  

Гистограмма дает общее представление о распределении пикселов в изображении. 

Концентрация деталей яркости в светах или тенях изображения свидетельствует о 

смещении его тонового интервала, которое выражается в снижении контраста. 

Определение тонового интервала изображения имеет важное значение для выбора 
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наиболее эффективных методов тоновой коррекции. 

Дополнительный модуль (Plug-in) 
Програмное обеспечение (чаще всего фильтры), разработанное сторонними компаниями 

для использования с программой Adobe Photoshop и некоторыми другими. 

Градации серого (Grayscale) 
Одноканальное представление изображения с 256 уровнями (градациями) серого цвета. 

На каждый пиксел изображения отводится 1 байт (8 бит). 

Градиент 
Плавный переход между двумя или несколькими цветами. 

Дуплекс (Duotone) 
Добавление цветной краски для улучшения печати черного-белого изображения. 

Заливка (Fill) 
Заполнение выделенной области или всего изображения оттенком серого цвета, 

сплошным цветом или декоративными образцами. 

Замена серой составляющей (GCR) 
Метод в цветоделении, при котором равные доли голубой, пурпурной, жеотой красок 

заменяются на соответсвующий оттенок черной краски. 

Изогелия 
Передача изображения огранниченным количеством цветов. 

Инверсия (Invert) 
Изменение тона или цвета на противоположный (например, черный цвет на белый). 

Индексированные цвета (Indexed Colors) 
Одноканальное представление фиксированного набора цветов ( обычно 16 или 256). 

Интервал (Spacing) 
Параметр, определяющий расстояние между штрихами в мазке 

инструмента Paintbrush (Кисть) или другого рисующего инструмента. 

Интерфейс 
Основное окно, в котором располагаются все необходимое для работы. 

Кадрирование (Cropping) 
Ограничение части изображения с целью удаления лишнего и достижения большей 

художественной выразительности. 

Калибровка 
Процесс настройки устройств (например, монитора) для более точной передачи цвета с 

одновременным учетом реальных полиграфических возможностей. 

Калибровочная шкала 
Шкала градаций серого цвета. 

Канал (Channel) 
Компьютерная форма отображения каждой составляющей цветовой модели, аналог 

цветоделенной формы в полиграфическом процессе. 

Клонирование 
Копирование фрагмента изображения в интерактивном режиме с помощью специального 

инструмента Rubber Stamp (Штамп). 

Контраст 
Степень тонового различия между областями изображения. Максимальный контраст - 

белое и черное без всяких переходов, низкий контраст - сближенные тона без резких 

переходов. 

Контур (Path) 
Представление изображения с помощью векторных обьектов, обычно основанных на 

использовании специального математического аппарата кривых Безье. 

Линиатура растра (Frequency) 
Плотность точек в полутоновом растре, выражаемая обычно в линиях на дюйм - LPI 

(Lines per Inch). 
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Маркировка (Labels) 
Опция, обеспечивающаяразмещение на оттиске служебной информации об изображении 

(имени файла, названия канала и т. д.). 

Метки обреза 
Метки, печатаемые вдоль границ изображения, служат указанием для обрезки. 

Метки приводки 
Метки, помещаемые на цветоделенных печатных оттисках и используемые для 

совмещения цветов в процессе печати. 

Муар (Moire) 
Паразитный узор на цветном оттиске, получающийся при неверной приводке, 

неправильных утлах наклона растра и некоторых других технических условиях. 

Насыщенность (Saturation) 
Характеристика цвета, определяющая чистоту цвета. Используется в цветовой 

модели НSВ. 

Обесцвечивание (Fading) 
Расстояние, на котором "иссякает" краска у 

инструментов Рaintbrush (Кисть), Airbrush (Азрограф). Эффект призван увеличить 

соответствие компьютерных инструментовн их реальным прототипам. 

Обтравочный контур (Clipping Patch) 
Контур, создаваемый с помощью инструмента "Перо". Предназначается для передачи в 

другие программы при использован качестве маски. 

Опорная точка (Anchor Point) 
Элемент сегмента контура - начальный или конечный узел. 

Палитра (Palette) 
Способ вывода информации на экран; средство управления циальными окнами, которые 

можно свободно перемещать, сворачивать и разворачивать. 

Передаточная функция (Transfer Function) 
Функция, позволяющая устанавливать нелинейную зависимость между входными и 

выходными данными. Используется при цветоделении, цветовой коррекции и т.д. 

Пиксел (Pixel) 
Минимальный элемент изображения на мониторе или в точечном изображении. 

Пиктограмма 
Графический символ, представляющий программу, команду, инструмент и т. Д 

Используется как более эргономичный способ управления программой. 

Плавающая обласпть (Floating Selectiorl) 
Выделенная область, временно существующая над изображением, с которой можно 

производить перемещения и различного рода трансформации, не оказывая при этом 

никакого влияния на само изображение. 

Постеризовать (Posterize) 
Уменынение количества тонов (цветов) для последующей передачи изображения. 

Используется для художественных целей или вцелях подготовки изображения для 

трассировки. 

Приводка (Registration) 
Совмещение цветоделенных полос по меткам приводки в процессе печати с целью 

получения полноцветного изображения. 

Пункт (Point) 
Основная единица полиграфической системы мер, Равна 1/72 дюйма.. Используется в 

основном для измерения размеров шрифтов. 

Разрешение (Resolution) 
Количество пикселов на единицу длины (обычно дюйм). 

Растискивание точек (Dots Gain) 
Дефект печати, вызываемый разными техническими причинами, состоящий в увеличении 
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оттиска растровой точки на бумаге, что ведет к усилению плотностя изображения. 

Растр (Halftone) 
В полиграфии техника передачи непрерывного тона с помощью бинарной структуры 

черного и белого. Тональным градациям ставятся в соответствие размеры точек. 

Физический размер точек достаточно мал, и при восприятии они сливаются и более  или 

менее имитируют тональный диапазон. 

Растушевка (Feather) 
Частичное распространение изменений, производимых в пределах  выделенной области, 

за ее границы. Позволяет смягчить слияние изображения в выделенной области и 

остального рисунка. 

Ретушь (Retouch) 
Коррекция изображения с целью устранения мелких дефектов, а ткже исправления 

тонального и цветового балансов. 

DPI 
Единица измерения разрешения Dots рег Inch (количество точек в дюйме). 

Сведение слоев (layers Меrging ) 
Объединение всех видимых слоев в один с учетом режимов слияния, непрозрачности и 

прочих условий. 

Света (Highlights) 
Светлые тона изображения, на полутоновом растрированном изображении 

представляются точками малого размера. 

Сглаживание (Anti-aliasing) 
Технический прием, в результате которого "ступенчатость" границ и линий в 

изображениях точечной графики сглаживается путем смягчения интенсивности в 

переходной области. 

Сканер 
Электронное устройство ввода данных, которое преобразует двухмерные графические 

изображения в компьютерную (цифровую) форму. 

Слой (Layer) 
Дополнительный уровень для рисования. Метафора прозрачной кальки в традиционном 

дизайне. 

Средние тона (Midtones) 
Тона изображения в диапазоне между светами и тенями. 

Совмещенные данные (Sample Merged) 
Опция, позволяющая работать с изображением на всех слоях. 

Тени (Shadows) 
Темные тона изображения; на полутоновом растрированном изображении 

представляются точками большого размера. 

Тон 
Уровень (градация) серого цвета. 

Тоновое изображение 
Изображение, имеющее непрерывную (или условно непрерывную) шкалу серых градаций 

от белого до чериого. 

Точечная графика 
Изображение, состоящее их совокупности точек (пикселов). Каждый пиксел имеет 

атрибут цвета, кодируемый от 1 бита (черно-белый штрих) до 24 бит (цветное 

изображение с 16,7 млн оттенков). 

Трансформации 
Изменения выделенной области (перемещение, масштабирование  поворот, перспектива, 

деформация). В точечной графике трансформации обычно связаны с искажениями. 

Треппинг (Trapping) 
Увеличение площади более светлого цвета для предотвращения появления пустых 
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зазоров при перекрытии более темным цветом. 

Триадные краски (Process Co1ors) 
Три основные краски (голубая, пурпурная, желтая) и дополнительная (черная), 

используемые в стандартном печатном процессе. Синоним СМYК-цветов. 

Угол наклона растра 
Угол наклона линий растра для разных цветов, применяемый для распределения истовых 

точек в розетку. 

Цветоделение (Color Separation) 
Процесс разложения цветного изооражения на четыре составляющие стандартного 

печатного процесса и получение отдельных фотоформ для каждой составляющей. 

Цветовая модель 
Визуальное и цифровое представление параметров цвета в зависимости от конкретных 

практических требований. 

Цветовая модель CMYK 
Цветовое пространство, основанное на четырех цветах полиграфического процесса - 

голубом, пурпурном, желтом и черном. 

Цветовая модель HSB 
Цветовое пространство, основанное на трех характеристиках цвета: цветовом 

тоне (Hue), насыщенности (Saturation) и яркости (Brightness). 

Цветовая модель RGB 
Цветовое пространство, основанное на трех цветах - красном, зеленом и синем. 

Цветовая таблица (Color Look - Таblе) 
Матрица цветовых параметров, используемая для вывода цвета на экран, для 

конвертирования цвета из одной модели в другую и т. д. 

Цветовой баланс 
Соотношение цветов в изображении; отображается на цветовых полосах, позволяющих 

добавить или уменьшить содержание одного цвета за счет другого. 

Цветовой тон (Hue) 
Основная характеристика цвета, отличающая его от других цветов, например, оранжевый 

от синего, фиолетовый от розового и т.д. Используется в модели HSB. 

Цветокоррекция 
Изменение параметров цвета пикселов (яркости, контрастности, цветового тона, 

насыщенности) с целью достижения оптимальных результатов печати. 

Шум (Noise) 
Совокупность пикселов, цветовые значения которых распределяются случайным 

образом. 

Яркость 
Характеристика цвета, определяющая интенсивность цвета. Используется в цветовой 

модели HSB. 
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Раздел 4. Краткий конспект лекций 

Лекция 1 Графические пакеты. Современные графические системы. 
Photoshop. 

Одним из наиболее интенсивно развиваемых направлений программных средств 

для персональных компьютеров являются различные графические пакеты (для создания 

графических образов или обработки изображений). Человек получает более 90% 

информации с помощью зрения и, следовательно, представление информации в 

графическом виде для него наиболее естественно. 

Графические пакеты можно классифицировать следующим образом: 

1. Для подготовки изображений. Основная их черта – создание новых графических 

образов. В этой группе можно выделить пакеты: 

 Инженерной графики. Включает большое количество различных систем 

автоматизации проектирования (САПР) 

 Научной графики. Предназначены для обработки и представления в 

графической форме результатов научных экспериментов 

 Деловой графики. Позволяют строить большое количество разнообразных 

диаграмм на основе табличных данных из деловой сферы 

 Двухмерной и трехмерной иллюстративной и художественной графики 

(статической и динамической). Обеспечивают дизайнера и художника 

неограниченным набором инструментов и позволяют ему создавать на экране 

персонального компьютера различные графические образы. Наличие этих 

программных средств и их необыкновенные свойства привели даже к 

созданию нового вида живописи – люменографии, а также до неузнаваемости 

изменило некоторые сферы мира кино и мультипликации  

2. Для обработки изображений. Характерной чертой является предварительные 

ввод реального изображения в компьютер с целью дальнейшего его 

преобразования. Среди них можно выделить: 

 Специализированные. Используются в составе аппаратно – программных 

комплексов, ориентированных на решение конкретных задач в научно – 

исследовательской и прикладной сфере (медицина, биология, криминалистика, 

геология, космическая разведка и т. п.) 

 Универсальные. Используются более широко, так как для ввода изображений 

ориентируются на стандартное оборудование (сканеры, платы видео ввода). 

 

Лекция 2 Графическая информация. Типы компьютерных изображений 
Цифровые изображения делятся на три класса: векторные, растровые и 

фрактальные. Векторные изображения наиболее хорошо подходят для использования в 

качестве технических иллюстраций, но они не обеспечивают нужного качества при 

создании фотореалистических изображений. Это связано с ограниченной возможностью 

управления основными параметрами изображения, таких как фокусировка и 

освещенность. Некоторые типы растровых изображений, в частности, графические 

изображения с разрешением 1 бит/пиксел, практически не поддаются масштабированию, 

а векторные изображения можно масштабировать без каких – либо ограничений. 

Задание – Найти и рассмотреть основные понятия фрактальной графике 

Растровые изображения 

Чтобы компьютер смог обрабатывать рисунки, они должны быть представлены в 

числовой форме, или, как принято говорить, закодированы. Для кодирования рисунок 

разбивают на небольшие одноцветные части. Все цвета, использованные в изображении, 

нумеруют, и для каждой части записывают номер ее цвета. Запомнив последовательность 

расположения частей и номер цвета для каждой части, можно однозначно описать любой 

рисунок. Однако, количество цветов в природе бесконечно, и приходится похожие цвета 

нумеровать одинаковыми числами. В зависимости от количества используемых цветов, 
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можно закодировать более или менее реалистичное изображение. Чем меньше цветов в 

рисунке, тем меньше номеров приходится использовать, и тем проще закодировать 

изображение. Рисунки, закодированные описанным способом, называются растровыми 

изображениями. 

Растровый файл представляет из себя прямоугольную матрицу (bitmap), 

разделенную на маленькие квадратики - пикселы (pixel — picture element). 

Растровая графика представляет собой сетку (растр), ячейки которой называются 

пикселями. Пиксели часто называют точками. Рисунок из множества пикселей можно 

сравнить с мозаикой. Каждый пиксел в растровом изображении имеет строго 

определённое местоположение и цвет, следовательно любой объект представляется 

программой как набор окрашенных пикселов. Объем информации, описывающий цвет 

пикселя, определяет глубину цвета. Это значит, что пользователь, работая с растровыми 

изображениями, работает не над конкретными объектами, а над составляющими их 

группами пикселов. 

Растровые изображения обеспечивают высокую точность передачи градаций цветов 

и полутонов, а также высокую детализацию изображения, поэтому они являются 

оптимальным средством представления тоновых изображений, таких как сканированные 

фотографии. 

Для изображения растровой графики всегда используется фиксированное 

количество пикселов, т.е. качество растрового изображения напрямую зависит от 

разрешающей способности оборудования. Это значит, что любое изменение изображения 

(поворот, увеличение и т.д.) приводит к неизменному искажению картинки и границы 

объектов получаются неровными. Т.е. растровые изображения обладают одним очень 

существенным недостатком: их трудно увеличивать или уменьшать, то есть 

масштабировать. При уменьшении растрового изображения несколько соседних точек 

преобразуются в одну, поэтому теряется разборчивость мелких деталей изображения. 

При увеличении - увеличивается размер каждой точки, поэтому появляется ступенчатый 

эффект. 

Растровое изображение ближе к фотографии, поскольку позволяет более точно 

воспроизводить основные характеристики фотографии: освещенность, прозрачность и 

глубину резкости. Для синтеза растровых изображений необходимо задавать разрешение 

и размеры изображения. Наиболее часто растровые изображения получают путем 

сканирования фотографий. С помощью средств растровой графики можно отразить и 

передать всю гамму нюансов и тонких эффектов, присущих реальному изображению. 

Одна из характеристик растровых изображений разрешение. 

Разрешение - это плотность размещения пикселей, формирующих изображение, то 

есть количество пикселей на заданном отрезке. Чаще всего разрешение измеряется в 

количестве точек на дюйм - dpi (Dot Per Inch). 

При отображении рисунков на мониторе, используют разрешение от 72 dpi до 120 

dpi. При печати самым распространенным разрешением является 300 dpi, но для 

получения высококачественных отпечатков на современных цветных принтерах можно 

использовать и большее разрешение. Растровые изображения достаточно широко 

используются в вычислительной технике. Фотографии и рисунки, введенные в 

компьютер, хранятся именно в виде растровых изображений. Большинство рисунков во 

всемирной компьютерной сети Интернет представляют собой растровые файлы. 

 

Лекция 3 Векторные изображения 
Векторные изображения формируются на основе математически описанных фигур, 

называемых векторами, а вид изображения определяется параметрами векторов. Другими 

словами, векторная графика состоит из кривых, имеющих координаты, цвет и прочие 

параметры, а также замкнутых областей, заполненных определенным цветом. Границы 

этих областей также описываются кривыми (так называемых примитивами, в качестве 
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которых могут выступать линии, дуги, окружности и т.п.). Файл с векторным 

изображением содержит координаты и параметры кривых. 

Например, чтобы закодировать круг, не надо разбивать его на отдельные пиксели, а 

следует запомнить его радиус, координаты центра и цвет. Для прямоугольника 

достаточно знать размер сторон, место, где он находится и цвет заливки. С помощью 

математических формул можно описать самые разные фигуры. Чтобы нарисовать более 

сложный рисунок, применяют несколько простых фигур. 

Любое изображение в векторном формате состоит из множества составляющих 

частей, которые можно редактировать независимо друг от друга. Эти части называются 

объектами. С помощью комбинации нескольких объектов, можно создавать новый 

объект, поэтому объекты могут иметь достаточно сложный вид. Для каждого объекта, его 

размеры, кривизна и местоположение хранятся в виде числовых коэффициентов. 

Благодаря этому появляется возможность масштабировать изображения с помощью 

простых математических операции, в частности, простым умножением параметров 

графических элементов на коэффициент масштабирования. При этом качество 

изображения остается без изменений. Векторную графику называют также объектно - 

ориентированной, потому что файл изображения формируется из дискретных, не 

связанных между собой элементов изображения. 

Векторные изображения не могут быть созданы путем сканирования. Они 

создаются с помощью специальных программных средств типа CorelDRAW и Adobe 

Illustrator.   

Основные преимущества программ такого рода: 

 Результаты обработки векторных изображений не зависят от разрешающей 

способности оборудования, поэтому можно произвольно изменять их параметры 

(размер, цвет, форму и т.д.) - качество не ухудшится. 

 Относительно малый вес (размер файла) готовых изображений. 

Векторная графика применяется при создании цифровых объектов с 

использованием мелких кеглей (размеров шрифта) или таких объектов, как логотипы, для 

которых важно сохранять четкие контуры, при неограниченном масштабировании. 

Недостатком работы с векторной графикой является некоторая условность 

получаемых изображений. Так как все рисунки состоят из кривых, описанных 

формулами, трудно получить реалистичное изображение. Для этого понадобилось бы 

слишком много элементов, поэтому рисунки векторной графики не могут 

использоваться для кодирования фотографий. 

Лекция 4-7 Растровая графика 
Для работы компьютерных программ вся требуемая информация должна быть 

преобразована (кодирована) в цифровую форму. 

В зависимости от способа кодирования графической информации компьютерную 

графику можно разделить на два вида: растровая графика (raster graphics) и векторная 

графика (vector drawing). 
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Сущность растровой графики 
Растровая графика представляет изображение в виде матрицы одинаковых по 

размеру прямоугольных элементов, именуемых пикселами, которые различаются только 

цветом (тоном) и взаимным расположением. Простейшее растровое изображение, 

отдаленно напоминает лист клетчатой бумаги, на котором каждая клетка закрашена 

черным или белым цветами, в совокупности образующими форму рисунка. Кратко 

опишем процесс оцифровки (кодирования) изображения: 

 
Шаг 1. Помещаем изображение-«оригинал» в сетку координат. При этом, 

изображение “разрезается” на элементы “квадратики” (независимые друг от друга 
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элементы — «дискреты»). Каждый элемент получает свое уникальное положение в сетке 

дискретизации. 

Заметим, на этом этапе «квадратики» не имеют изобразительного содержания, они 

все одинаковые. 

Шаг 2. Чтобы передать хоть какое-то содержание, мы должны научиться различать 

эти элементы по какому-либо принципу. Для этого составляется таблица квантования 

изображения. 

Таблица квантования 

Значение цвета Коды 

Черный 0 

Белый 1 

Поскольку в оригинальном изображении используются только два ахроматических 

цвета, их можно представить как два состояния. Для того, чтобы закодировать два 

состояния, требуется всего один бит информации. 

Бит (от англ. bit — binary digit, двоичная цифра) — минимальная единица 

информации, принимающая одно из двух значений: ноль или единица. 

Байт (от англ. byte) — восемь битов.  

1 Кбайт (килобайт) = 1024 байт.  

1 Мбайт (мегабайт) = 1024 Кбайт.  

1 Гбайт (гигабайт) = 1024 Мбайт. 

Шаг 3. Затем, начинаем кодировать исходное изображение (“оригинал”) по двум 

состояниям, т. е. оценивать каждый дискретный элемент по составленной нами таблице 

квантования. Там, где в “оригинале” дискретные ячейки имеют белый цвет, в 

соответствующие им ячейки матрицы (битовой карты) записываются “единицы”. А там, 

где в “оригинале” представлены ячейки черного цвета, записываются “нули”. 

После полного заполнения всех ячеек матрицы можно считать, что процесс 

оцифровки исходного изображения завершился. Полученная битовая карта может быть 

записана любым компьютерным способом. 

Пиксел 
Пиксел (pixel) — это однородный и неделимый элемент дискретизации 

изображений. Все пикселы одинаковые по размеру и форме. Различаются пикселы только 

цветом (тоном) и взаимным расположением. 

Слово «пиксел» представляет собой сокращение английских слов picture element, 

что означает “элемент изображения”, “элемент картинки”. Эти два слова сократили до 

“pic” и “el” и соединили, получилось слово “pixel”. При этом буква “с” заменена на “х”. В 

русском языке слово встречается в двух вариантах — “пиксел” и “пиксель”. В литературе 

чаще встречается написание “пиксел”. 

Разрешение 
В битовой карте отсутствует указание на реальный размер элемента (пиксела). В 

таком случае одна и та же битовая карта может быть визуализирована по разному, если 

элементы, из которых строится изображение-«оттиск», имеют различные размеры. Для 

того чтобы установить единую меру дискретизации, было разработано понятие 

разрешения, которое однозначно связывает размер элемента дискретизации со 

стандартными единицами измерения. 

Разрешение — это количество дискретных элементов (пикселов) в единицу длины. 

Разрешение представляет собой достаточно универсальное понятие, которое применяется 

в разных областях, имеющих дело с изображениями (например, в телевидении, 

полиграфии и компьютерной графике). 

В качестве стандартной единицы длины принята британская мера длины — дюйм 

(inch), равный 25,4 мм. 



31 

 

Разрешение обычно обозначается как ppi (читается «пи-пи-ай»), что является 

сокращением от словосочетания «pixels per inch» и переводится как “пикселов в каждом 

дюйме”. 

Единица измерения разрешения ppi — это количество пикселов в каждом дюйме 

изображения. Исходя из такого определения и считая, что длина квадрата, изображенного 

на используемом ранее “оригинале”, равна одному дюйму, можно сказать, что 

разрешение этого пиксельного изображения соответствует 6 ppi. Это означает, что в 

каждом дюйме умещается по 6 элементов (пиксела). 

 
Глубина цвета 
Глубина цвета (color depth) — это число битов, используемых для хранения 

информации о цвете каждого пиксела. Чем больше глубина цвета, тем более качественно 

смотрится изображение. Следует обратить внимание, что понятие глубины цвета — это 

метафора. Специалисты, которые ввели в оборот это понятие, представили мысленно, как 

дополнительные битовые матрицы располагаются “как бы” в глубину. 

 
В отличие от разрешения, параметр “глубина цвета” не может определяться 

произвольно, а применяются несколько довольно строгих вариантов: черно-белые 

изображения (bitmap), 1 Бит — 2 цвета; изображения в градациях серого (grayscale), 8 Бит 

— 256 цветов; полноцветные изображения (truecolor) 24 Бит — 16 миллионов цветов. 

Существуют также их варианты: дуплексные изображения (duotone) и изображения с 

индексированными цветами (indexed colors). 

Объем файла растровой графики 
Объем файла для хранения растрового изображения определяется произведением 

его площади на разрешение и на глубину цвета (в случае, если они приведены к единой 

размерности).Формула расчета объема растрового файла в битах: 

V= L x W x R2 х D, 

где L и W — длина и ширина изображения в дюймах;  
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R — разрешение изображения в ppi;  

D — глубина цвета в битах. 

Рассмотрим пример расчета объема растрового файла. 

Предположим, что необходимо рассчитать объем дискового пространства для 

хранения цветного изображения (RGB 24 бит) размером 102x152 мм (фото 10х15) и 

разрешением 300 ppi. Начнем с того, что значения длины и ширины необходимо 

представить в дюймах: 

L = 102 : 25,4 = 4 (дюймов); 

W= 152 : 25,4 = 6 (дюймов). 

Площадь изображения, как всем известно, вычисляется перемножением этих 

величин: 

S = L x W= 4 х 6 = 24 (квадратных дюймов). 

Следующим шагом необходимо вычислить общее количество пикселов. Но, сначала 

необходимо вычислить количество пикселов в квадратном дюйме: 

N1 = R2 = 300 х 300 = 90 000 (пикселов). 

А поскольку площадь изображения составляет не один квадратный дюйм, то общее 

количество пикселов будет равно: 

N = N1 х S= 90 000 х 24 = 2 160 000 (пикселов). 

Таким образом, все изображение состоит из 2 160 000 пикселов, каждый из которых 

требует 24 бита или 3 байта для кодирования информации о цвете. Следовательно, объем 

файла V будет равен: 

V = N х D = 2 160 000 х 3 = 6 480 000 (байт). 

Для того чтобы это значение пересчитать в килобайты, полученное число 

необходимо разделить на 1024: 

V = 6 480 000 : 1024 = 6 328,125 (килобайта). 

Для того чтобы это значение пересчитать в Мб, полученное число необходимо 

разделить на 1024: 

V = 6 328,125 : 1024 = 6,18 (Мбайт). 

Полученный результат можно проверить в программе Adobe Photoshop. Для этого 

достаточно создать новый документ. 

 
Таким образом, объем файла растровой графики однозначно определяется 

произведением площади изображения на разрешение и на глубину цвета. При этом 

совершенно не важно, что изображено на фотографии: деревянный одноцветный столб 

или коллекция бабочек с обилием цвета и форм. Если три параметра одинаковы, размер 

файла будет практически одинаковым. 

Особенности растровой графики 
Достоинства растровой графики: 
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Основным достоинством растровых изображений является возможность передавать 

огромное количество цветовых оттенков и плавных переходов между ними. Поэтому, 

растровое изображение имеет преимущества при работе с фотореалистичными 

объектами, например сценами природы или фотографиями людей. Лишь качественные 

растровые изображения способны передать все многообразие процессов и явлений, 

воспринимаемых зрением человека. 

Форматы файлов, предназначенные для сохранения растровых изображений, 

являются стандартными, поэтому не имеет решающего значения, в каком графическом 

редакторе создано то или иное изображение. 

Простота, и как следствие, техническая реализуемость ввода и вывода 

изобразительной информации. 

Недостатки растровой графики: 

Файлы растровых изображений как правило имеют очень большой объем. 

При попытке слегка повернуть на небольшой угол изображение, например, с 

четкими тонкими вертикальными линиями, четкие линии превращаются в четкие 

“ступеньки” (aliasing). Любые трансформации (повороты, масштабирование, наклоны) в 

растровой графике приводят к искажениям. 

Невозможно увеличить изображение для рассмотрения деталей. Поскольку 

изображение состоит из точек, то увеличение изображения приводит только к тому, что 

эти точки становятся крупнее. Никаких дополнительных деталей при увеличении 

растрового изображения рассмотреть не удается. Более того, увеличение точек растра 

визуально искажает иллюстрацию и делает ее грубой. 

Текст в растровой графике оказывается проблемой. После сохранения изображения 

с текстовой надписью, например в формате JPEG, текст можно редактировать только как 

обычную графику. Для векторной графики редактирование текста не является проблемой. 

Кроме того, при большом разрешении файл растрового текста будет огромного размера. 

Например, страница текста (A4) в формате CDR (собственный формат программы 

CorelDraw) “весит” 16 Кб, а в формате TIFF — 1 096 Кб. 

Несмотря на перечисленные недостатки, растровая графика, благодаря своим 

богатым изобразительным возможностям является одной из самых захватывающих 

областей компьютерной графики.  

Лекция 8 Маски 
Маска - это выделенная область растрового изображения, допускающая обработку 

составляющих данную область пикселей. Можно не только формировать маски любых 

форм, но и делать их частично прозрачными. Используя такие маски, вы можете 

накладывать одно изображение на другое, а также выполнять частичную обработку 

изображений. Маску можно сформулировать различными способами, в частности, с 

помощью специально предназначенных для этого инструментов выделения. 

Другой способ создания масок состоит в использовании контуров. 

Контур - это вспомогательный векторный объект, который используется для 

выполнения различных операций по обработке растровых изображений. Вы можете 

редактировать маску, используя для этого один из инструментов рисования (например, 

кисть или карандаш), а также любой из инструментов заливки (обычной или гардинной), 

предварительно выделив область заливки. При этом рисование или заливка производится 

цветом переднего плана, выбранным вами. 

В программе Adobe Photoshop предусмотрено несколько способов 

редактирования масок, основным из которых является так называемое 

редактирование в режиме быстрой маски. 

Переход в режим быстрой маски происходит с помощью кнопки Edit in 

Quick Mask Mode (Редактирование в режиме быстрой маски), находящейся в 

нижней части блока инструментов. При этом замаскированная область 

отображается полупрозрачным красным цветом (цвет и плотность раскраски 
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быстрой маски можно регулировать). 

Если этот цвет черный, то фактически вы рисуете цветом раскраски маски, 

используемый в режиме Edit in Quick Mask Mode, т.е. красным. При этом доступная для 

редактирования область изображения уменьшается (маскируемая область увеличивается). 

Если же выбранный цвет белый, то в месте воздействия инструмента рисования или 

заливки красный цвет маски удаляется, т.е. появляются новые незамаскированные 

области. Если выбран любой другой цвет переднего плана, то он трансформируется в 

оттенок серого. Рисование этим (любым кроме белого) цветом приводит к 

раскрашиванию области действия инструмента в розовый оттенок. Это соответствует 

частично прозрачной области редактирование. 

Channels (Каналы) 

Программа Adobe Photoshop предоставляет в распоряжение 

пользователя еще один инструмент для более продуктивной 

работы. Это так называемые каналы. Программа использует их 

в двух целях: для хранения цветовой информации и масок 

выделения. Что касается цветовых каналов, то они создаются 

автоматически при открытии нового документа. В зависимости 

от цветового режима изображения, цветовых каналов может 

быть несколько. В каждом документе Adobe Photoshop 

произвольно, по вашему желанию, можно создавать 

дополнительные, или альфа-каналы, цель которых - хранить маски выделения, 

позволяющие закрыть от модификации отдельные фрагменты изображения в процессе 

редактирования. 

Лекция 9 Понятие цвета и его характеристики 
Цвет – чрезвычайно сложная проблема, как для физики, так и для физиологии, т.к. 

он имеет как психофизиологическую, так и физическую природу. Восприятие цвета 

зависит от физических свойств света, т. е. электромагнитной энергии, от его 

взаимодействия с физическими веществами, а также от их интерпретации зрительной 

системой человека. Более того, одни предметы отражают свет (доска, бумага), а другие 

его пропускают (стекло, вода). Если поверхность, которая отражает только синий свет, 

освещается красным светом, она будет казаться черной. Аналогично, если источник 

зеленого света рассматривать через стекло, пропускающее только красный свет, он тоже 

покажется черным. 

Самым простым является ахроматический цвет, т.е. такой, какой мы видим на 

экране черно–белого телевизора. При этом белыми выглядят объекты, ахроматически 

отражающие более 80% света белого источника, а черными – менее 3%. Единственным 

атрибутом такого цвета является интенсивность или количество. С интенсивностью 

можно сопоставить скалярную величину, определяя черное, как 0, а белое как 1. 

Если воспринимаемый свет содержит длины волн в произвольных неравных 

количествах, то он называется хроматическим.  

При субъективном описании такого цвета обычно используют три величины: 

цветовой тон, насыщенность и светлота. 

Цветовой тон позволяет различать цвета, такие как красный, зеленый, желтый и т.д. 

(это основная цветовая характеристика). 

Насыщенность характеризует чистоту, т.е. степень ослабления (разбавления, 

осветления) данного цвета белым светом, и позволяет отличать розовый цвет от красного, 

изумрудный от ярко–зеленого и т. д. Другими словами, по насыщенности судят о том, 

насколько мягким или резким кажется цвет. 

Светлота отражает представление об интенсивности, как о факторе, не зависящем 

от цветового тона и насыщенности (интенсивность (мощность) цвета). 

Обычно встречаются не чистые монохроматические цвета, а их смеси. В основе 

трехкомпонентной теории света лежит предположение о том, что в центральной части 
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сетчатки глаза находятся три типа чувствительных к цвету колбочек. Первый 

воспринимает зеленый цвет, второй – красный, а третий – синий цвет. Относительная 

чувствительность глаза максимальна для зеленого цвета и минимальна для синего. Если 

на все три типа колбочек воздействует одинаковый уровень энергетической яркости, то 

свет кажется белым. Ощущение белого цвета можно получить, смешивая любые три 

цвета, если ни один из них не является линейной комбинацией двух других. Такие цвета 

называют основными. 

Человеческий глаз способен различать около 350 000 различных цветов. Это число 

получено в результате многочисленных опытов. Четко различимы примерно 128 

цветовых тонов. Если меняется только насыщенность, то зрительная система способна 

выделить уже не так много цветов: мы можем различить от 16 (для желтого) до 23 (для 

красного и фиолетового) таких цветов.  

Для характеристики цвета используются следующие атрибуты: 

 Цветовой тон. Можно определить преобладающей длиной волны в спектре 

излучения. Цветовой тон позволяет отличать один цвет от другого – например, 

зеленый от красного, желтого и других. 

 Яркость. Определяется энергией, интенсивностью светового излучения. 

Выражает количество воспринимаемого света. 

 Насыщенность или чистота тона. Выражается долей присутствия белого 

цвета. В идеально чистом цвете примесь белого отсутствует. 

Указанные три атрибута позволяют описать все цвета и оттенки. То, что атрибутов 

именно три, является одним из проявлений трехмерных свойств цвета. 

Факторы, влияющие на внешний вид конкретного цвета:  

 источник света; 

 информация об окружающих предметах; 

 ваши глаза;  

Правильно подобранные цвета могут, как привлечь внимание к желаемому 

изображению, так и оттолкнуть от него. Это объясняется тем, что в зависимости от того, 

какой цвет видит человек, у него возникают различные эмоции, которые подсознательно 

формируют первое впечатление от видимого объекта. 

Цвет в компьютерной графике нужен для того, что: 

 он несет в себе определенную информацию об объектах. Например, летом 

деревья зеленые, осенью – желтые. На черно–белой фотографии определить 

пору года практически невозможно, если на это не указывают какие–либо 

другие дополнительные факты. 

 цвет необходим также для того, чтобы различать объекты. 

 с его помощью можно вывести одни части изображения на первый план, другие 

же увести в фон, то есть акцентировать внимание на важном – композиционном 

– центре. 

 без увеличения размера при помощи цвета можно передать некоторые детали 

изображения. 

 в двумерной графике, а именно таковую мы видим на мониторе, так как он не 

обладает третьим измерением, именно при помощи цвета, точнее оттенков, 

имитируется (передается) объем. 

 цвет используется для привлечения внимания зрителя, создания красочного и 

интересного изображения. 
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Одной из характеристик любого компьютерного изображения является глубина цвета. 

Максимальное количество цветов, которое может быть использовано в изображении 

данного типа, называется глубиной цвета. 

Кроме полноцветных, существуют типы изображений с различной глубиной цвета – 

черно–белые штриховые, в оттенках серого, с индексированным цветом. Некоторые типы 

изображений имеют одинаковую глубину цвета, но различаются по цветовой модели. 

 

Лекция 10 Цветовые модели и их виды  
Каждый пиксель растрового изображения содержит информацию о цвете. Любой 

векторный объект также содержит информацию о цвете его контура и закрашенной 

области. Информация может занимать от одного до тридцати двух бит, в зависимости от 

глубины цвета. При работе с черно-белыми изображениями, цвет кодируется нулем или 

единицей. Для рисунков, содержащих 256 цветов или столько же градаций серого цвета, 

нетрудно пронумеровать все используемые цвета. Но, для изображений в истинном 

цвете, содержащих миллионы разных оттенков, простая нумерация не подходит. Для них 

разработаны несколько моделей представления цвета, помогающих однозначно 

определить любой оттенок.  

Цветовая модель определяет способ создания цветов, используемых в изображении, 

т.е. это способ описания цвета с помощью количественных характеристик.  

Цветовые модели могут быть:  
аппаратно–зависимыми (RGB и CMYK)  

аппаратно–независимыми (модель Lab).  

В большинстве «современных» визуализационных пакетов (например, в Photoshop) 

можно преобразовывать изображение из одной цветовой модели в другую.  

В цветовой модели (пространстве) каждому цвету можно поставить в соответствие 

строго определенную точку. В этом случае цветовая модель – это просто упрощенное 

геометрическое представление, основанное на системе координатных осей и принятого 

масштаба.  

Основные цветовые модели:  
1. RGB;  

2. CMY (Cyan Magenta Yellow);  

3. CMYK (Cyan Magenta Yellow Key, причем Key означает черный цвет);  

4. HSB (Hue тон (цвет), Saturation насыщенность, яркость – Brightness);  

5. Lab;  

6. HSV (Hue, Saturation, Value тон, насыщенность, количество света);  

7. HSL (Hue, Saturation, Lightness - цветовой тон, насыщенность и светлость);  

 

В цифровых технологиях используются, как минимум четыре, основных модели: 

RGB, CMYK, HSB в различных вариантах и Lab.  

По принципу действия, перечисленные цветовые модели можно условно 

разделить на три класса:  
1. аддитивные (RGB), основанные на сложении цветов;  

2. субтрактивные (CMY, CMYK), основу которых составляет операция вычитания 

цветов (субтрактивный синтез);  

3. перцепционные (HSB, HSL, LAB,), базирующиеся на восприятии.  

Компьютерная графика Долгоульский О.В.  



37 

 

Аддитивный цвет получается на основе законов Грассмана путем соединения лучей 

света разных цветов. В основе этого явления лежит тот факт, что большинство цветов 

видимого спектра могут быть получены путем смешивания в различных пропорциях трех 

основных цветовых компонент. Этими компонентами, которые в теории цвета иногда 

называются первичными цветами, являются красный (Red), зеленый (Green) и синий 

(Вlue) цвета. При попарном смешивании первичных цветов образуются вторичные цвета: 

голубой (Сyan), пурпурный (Magenta) и желтый (Yellow). Следует отметить, что 

первичные и вторичные цвета относятся к базовым цветам.  

Базовыми цветами называют цвета, с помощью которых можно получить 

практически весь спектр видимых цветов.  

Для получения новых цветов с помощью аддитивного синтеза можно использовать и 

различные комбинации из двух основных цветов, варьирование состава которых 

приводит к изменению результирующего цвета.  

Таким образом, цветовые модели (цветовое пространство) представляют средства для 

концептуального и количественного описания цвета.  

Цветовой режим – это способ реализации определенной цветовой модели в рамках 

конкретной графической программы.  

Д.З. Закон Грассмана (законы смешивания цветов) 
  

Лекция 11  Цветовая модель RGB 
Это одна из наиболее распространенных и часто используемых моделей. Она 

применяется в приборах, излучающих свет, таких, например, как мониторы, прожекторы, 

фильтры и другие подобные устройства. 

Данная цветовая модель базируется на трех основных цветах: Red – красном, Green 

– зеленом и Blue – синем. Каждая из вышеперечисленных составляющих может 

варьироваться в пределах от 0 до 255, образовывая разные цвета и обеспечивая, таким 

образом, доступ ко всем 16 миллионам цветов (полное количество цветов, 

представляемых этой моделью равно 256*256*256 = 16 777216.).  

Эта модель аддитивная. Слово аддитивная (сложение) подчеркивает, что цвет 

получается при сложении точек трех базовых цветов, каждая своей яркости. Яркость 

каждого базового цвета может принимать значения от 0 до 255 (256 значений), таким 

образом, модель позволяет кодировать 2563 или около 16,7 млн. цветов. Эти тройки 

базовых точек (светящиеся точки) расположены очень близко друг к другу, так что 

каждая тройка сливается для нас в большую точку определенного цвета. Чем ярче 

цветная точка (красная, зеленая, синяя), тем большее количество этого цвета добавится к 

результирующей (тройной) точке.  

При работе с графическим редактором Adobe PhotoShop можно выбирать цвет, 

полагаясь не на только, что мы видим, но при необходимости указывать и цифровое 

значение, тем самым иногда, особенно при цветокоррекции, контролировать процесс 

работы. 

Таблица 

Значения некоторых цветов в модели RGB 

Цвет R G B 

Красный (red) 255 0 0 

Зеленый (green) 0 255 0 

Синий (blue) 0 0 255 

Фуксин (magenta) 255 0 255 

Голубой (cyan) 0 255 255 

Желтый (yellow) 255 255 0 

Белый (white) 255 255 255 

Черный (black) 0 0 0 

Модель является аппаратно–зависимой, так как значения базовых цветов (а также 
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точка белого) определяются качеством примененного в мониторе материала. В 

результате на разных мониторах одно и то же изображение выглядит неодинаково. 

 
Модель RGB 

 

 
Цветовой куб модели RGB 

Система координат RGB – куб с началом отсчета (0,0,0), соответствующим черному 

цвету. Максимальное значение RGB – (255,255,255) соответствует белому цвету.  

 

Несомненными достоинствами данного режима является то, что он позволяет 

работать со всеми 16 миллионами цветов, а недостаток состоит в том, что при выводе 

изображения на печать часть из этих цветов теряется, в основном самые яркие и 

насыщенные, также возникает проблема с синими цветами. 

Модель RGB – это аддитивная цветовая модель, которая используется в 

устройствах, работающих со световыми потоками: сканеры, мониторы. 

 

Лекция 12 Модель CMY (Cyan голубой, Magenta фуксин (пурпурным), Yellow 
желтый) 

В этой модели основные цвета образуются путем вычитания из белого цветов 

основных аддитивных цветов модели RGB. 

Красный  

Зеленый  Синий  

Пурпурный  Желтый  

Голубой  
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Получение модели CMY из RGB 

Цвета, использующие белый свет, вычитая из него определенные участки спектра 

называются субтрактивными. Основные цвета этой модели: голубой (белый минус 

красный), фуксин (пурпурный) (белый минус зеленый) и желтый (белый минус синий). 

Эти цвета являются полиграфической триадой и могут быть легко воспроизведены 

полиграфическими машинами. 

При смешение двух субтрактивных цветов результат затемняется (в модели RGB 

наоборот). При нулевом значении всех компонент образуется белый цвет (белая бумага). 

Эта модель представляет отраженный цвет, и ее называют моделью субтрактивных 

основных цветов. 

Данная модель является основной для полиграфии и также является аппаратно–

зависимой.  

 
Модель CMY 

  

R 

G 

B 

C 

M 

Y 

Красный  

Черный 

Желтый  Голубой  

Пурпурный  

Зеленый  

Синий  
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Цветовой куб модели CMY 

Система координат CMY – тот же куб, что и для RGB, но с началом отсчета в точке 

с RGB координатами (0,0,0), соответствующей белому цвету. 
 

Лекция 13 Субтрактивная модель CMYK 
Модель CMYK (Cyan Magenta Yellow Key) – является дальнейшим улучшением 

модели CMY и уже четырехканальная. Поскольку реальные типографские краски имеют 

примеси, их цвет не совпадает в точности с теоретически рассчитанным голубым, 

желтым и пурпурным. Особенно трудно получить из этих красок черный цвет. Поэтому в 

модели CMYK к триаде добавляют черный цвет K (от слова Key – ключ). Модель CMYK 

является «эмпирической», в отличие от теоретических моделей CMY и RGB. Модель 

является аппаратно–зависимой.  

Основные цвета в субтрактивной модели отличаются от цветов аддитивной. Cyan – 

голубой, Magenta – пурпурный, Yellow – желтый. Так как при смешении всех 

вышеперечисленных цветов идеального черного не получится, то вводится еще один 

дополнительный цвет – черный, который позволяет добиваться большей глубины и 

используется при печати прочих черных (текст) объектов. 

Цвета в цветовой модели были выбраны такими, из–за того, что голубой поглощает 

лишь красный, пурпурный – зеленый, желтый – синий. 

В отличие от аддитивной модели, где отсутствие цветовых составляющих образует 

черный цвет, в субтрактивной все наоборот: если нет отдельных компонентов, то цвет 

белый, если они все присутствуют, то образуется грязно–коричневый, который делается 

более темным при добавлении черной краски, которая используется для затемнения и 

других получаемых цветов. При смешивании отдельных цветовых составляющих можно 

получить следующие результаты: 

Голубой + Пурпурный = Синий с оттенком фиолетового, который можно усилить, 

изменив пропорции смешиваемых цветов. 

Пурпурный + Желтый = Красный. В зависимости от соотношения входящих в него 

составляющих он может быть преобразован в оранжевый или розовый. 

Желтый + Голубой = Зеленый, который может быть преобразован при 

использовании тех же первичных цветов как в салатовый, так и в изумрудный. 

Модель CMYK – это субтрактивная цветовая модель, которая описывает реальные 

красители, используемые в полиграфическом производстве. 

Если вы готовите изображение к печати, то следует работать с моделью CMYK, 

потому что в противном случае то, что вы увидите на мониторе, и то, что получите на 

бумаге, будет не одинаковым. 

Лекция 14 Цветовая модель HSB (Hue тон (цвет), Saturation 
насыщенность, Brightness яркость). 
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Предложена в 1978 году. Все цвета располагаются по кругу, и каждому 

соответствует свой градус, то есть всего насчитывается 360 вариантов Hue. Hue - 

определяет частоту цвета и принимает значение от 0 до 360 градусов (красный – 0, 

желтый – 60, зеленый – 120 градусов и т.д.), т.е. любой цвет в ней определяется своим 

цветом (тоном), насыщенностью (то есть добавлением к нему белой краски) и яркостью. 

Насыщенность (Saturation) определяет, насколько ярко выраженным будет 

выбранный цвет. 0 – серый, 100 – самый яркий. 

Параметр яркости (Brightness) соответствует общепризнанному, то есть 0 – это 

черный цвет. 

Такая цветовая модель намного беднее рассмотренной ранее RGB, так как 

позволяет работать всего лишь с 3 миллионами цветов. 

Насыщенность (Saturation) – это параметр цвета, определяющий его чистоту. 

Уменьшение насыщенности цвета означает его разбеливание. Цвет с уменьшением 

насыщенности становится пастельным, блеклым, размытым. На модели все одинаково 

насыщенные цвета располагаются на концентрических окружностях, т. е. можно говорить 

об одинаковой насыщенности, например, зеленого и пурпурного цветов, и чем ближе к 

центру круга, тем все более разбеленные цвета получаются. В самом центре любой цвет 

максимально разбеливается, проще говоря, становится белым цветом. 

Яркость (Brightness) – это параметр цвета, определяющий освещенность или 

затемненность цвета. Амплитуда (высота) световой волны соответствует этому 

параметру. Уменьшение яркости цвета означает его зачернение. Работу с яркостью 

можно характеризовать как добавление в спектральный цвет определенного процента 

черной краски. Чем больше в цвете содержание черного, тем ниже яркость, тем более 

темным становится цвет. 

Модель HSB не зависит от оборудования и удобна для восприятия человеком, поэтому с 

ней часто работают различные программы, в дальнейшем преобразуя цвета в модель RGB 

для показа на экране монитора или в модель CMYK - для печати на принтере. Кроме 

того, модель HSB удобно использовать при редактировании рисунков. Например, вы 

хотите заменить зеленый лист на желтый в редактируемой фотографии. Достаточно 
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поменять только цветовую составляющую используемых цветов, не меняя яркость и 

насыщенность. Рисунок при этом не изменится, но примет иной оттенок. 

 
Лекция 15 Цветовая модель Lab, Цветовые режимы 

Цветовая модель Lab — это цветовая модель, разработанная с целью преодоления 

недостатков цветовых моделей HSB, RGB и CMYK. 

Любой цвет в модели определяется значением яркости L (Luminosity) и двумя 

цветовыми параметрами — а и b. Параметр a принимает все значения цвета по цветовому 

кругу — от зеленого до красного. Параметр b — от голубого цвета до желтого цвета. В 

природе не существует излучателей, которые могли бы воспроизвести диапазон цветовых 

значений параметров a и b, поэтому модель применяется в теоретических исследованиях, 

при обменах информацией о цвете и для синтеза цвета в компьютерных программах. 

Графический редактор Photoshop при переходе от режима RGB к CMYK использует 

Lab в качестве промежуточного этапа. 

Самым важным достоинством модели следует считать ее широкий цветовой 

диапазон: система Lab передает все цвета видимой части спектра. 

Цветовые режимы 

Цветовые режимы представляют собой практическую реализацию рассмотренных 

выше цветовых моделей. Если вы создаете изображение “с нуля”, то выбор цветового 

режима будет зависеть от назначения изображения (печать, web-графика и т. п.). 

Назовем и кратко охарактеризуем некоторые цветовые режимы, реализованные в 

большинстве графических программ: 

Bitmap (черно-белая графика). В этом режиме цвет пиксела может принимать 

только два состояния: черный и белый. Возможности редактирования изображений в 

режиме Bitmap существенно ограничены. Например, они не могут быть сглажены, к ним 

не применяются фильтры. В таком виде обычно хранятся текстовые документы, планы, 

чертежи и некоторые виды карандашных рисунков. 

Grayscale (градации серого). Этот режим применятся для хранения информации о 

полутоновых изображениях, имеющих 256 различных состояний. 

Duotone (дуплекс). В этом режиме изображение содержит два, три или четыре цвета 

заданных пользователем. Соответствует методу печати, при котором используются две 

или более печатные формы для получения более насыщенного и глубокого цвета в 

полутоновом изображении. 

На рисунке показано окно диалога настройки параметров режима Duotone в 

программе Adobe Photoshop CS. 

 
 

Лекция 16 Цветовой охват 
Цветовой охват — это диапазон цветов, который может воспроизводить модель или 

устройство.  

На рисунке схематически представлен график МКО (Международная комиссия по 
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освещению) отражающий цветовые охваты различных устройств и цветовых моделей. 

 
Самым широким цветовым охватом располагает нормальный человеческий глаз, он 

значительно шире того, что может воспроизвести цветная пленка. У цветной пленки 

диапазон шире, чем у цветного монитора, который в свою очередь имеет более широкий 

цветовой охват, чем у устройств цветной печати. Наибольшим цветовым охватом 

обладает модель Lab, в ней можно представить практически все цвета природы, которые 

способен воспринять человек. 
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Раздел 5. Методические указания для лабораторных занятий: 

ПРАКТИЧЕСКИЕ ЗАДАНИЯ 

Панель инструментов (Toolbox) – Photoshop 

Панель 

инструментов 

(Toolbox) – 

Photoshop 

содержит:  
кнопки 

графических 

инструментов 

Photoshop. Эти 

инструменты 

предназначен

ы для 

быстрого 

выполнения 

большинства 

операций и 

процедур, 

связанных с 

выделением, 

раскрашивани

ем, 

редактировани

ем и 

просмотром 

изображений; 

• 

управляющие 

элементы для выбора цветов переднего и заднего плана, переключения в режим Быстрая 

маска и изменения способа отображения изображений на экране. Некоторые 

инструменты (имеющие маленький треугольник в нижнем правом углу) содержат 

собственные раскрывающиеся панели дополнительных инструментов, открыть которые 

можно - нажав и не отпуская левую кнопку, затем подводим указатель и отпускаем 

кнопку мыши.  

Для выбора дополнительного инструмента можно щелкать по кнопке левой кнопкой 

мыши с нажатой клавишей Alt. 

Группы инструментов 

Инструменты выделения - для формирования выделенных областей (контрастных 

масок) и их перемещения.  

 

Restangular Marquee (Выделение прямоугольника) -Область. Выделяет 

прямоугольные области. Для получения квадратной области при ее выделении 

удерживайте клавишу Shift.  

 

Elliptical Marquee (Выделение эллипса) - Овальная область. Выделяет овальные 

области. Для выделения области в форме круга при ее выделении удерживайте 

клавишу Shift 

 Single Row Marquee (Выделение строки), Single Column Marquee (Выделение 
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столбца) - Вертикальная и горизонтальная строка. Определяет выделенную область 

как строку толщиной в один пиксел, проходящую по всему изображению. 

 
Crop (Обрезка) - Рамка. Вырезает из изображения выделенную область 

прямоугольной формы, отсекая ненужные фрагменты.  

 

 Lasso - Лассо. Выделение областей произвольной формы. 

 

Polygonal Lasso - Многоугольное лассо. Предназначено для выделения в 

изображении областей, ограниченных многоугольниками, составленными из отрезков 

прямых линий произвольной формы, т.е. можно создавать выделенные области по 

границам цветовых и тоновых переходов. 

 

Magnetic Lasso - Магнитное лассо. Используется для создания выделений вокруг 

объектов. Границы области "цепляются" за края объекта, на которых происходит 

смена цветового тона и насыщенности. 

 
Magic Wand - "Волшебная палочка". Выделяет фрагменты изображения на основе 

сходства цветов (близкими оттенками) смежных пикселов. 

 

Инструменты рисования и закрашивания.  

 Airbrush -Аэрограф. Используется для напыления цвета на поверхность изображения. 

 

Paintbrush - Кисть. Позволяет наносить мягкие мазки основным цветом - имитирует 

работу кисти, можно устанавливать и использовать в программе дополнительные 

наборы кистей. 

 
Eraser - Ластик. Используется для удаления оригинальных пикселов изображения 

путем закрашивания их в цвет фона. 

 
Pencil - Карандаш. Позволяет рисовать линии с резкими краями - как обычный 

карандаш. 

 
Line - Линия. Используется для рисования прямых линий. (В начале и в конце можно 

добавить стрелки.) 

 

Gradient - Градиент: Linear Gradient (Линейный Градиент ), Radial Gradient - 

Радиальный Градиент, Angle Gradient - Угловой Градиент , Reflected Gradient - 

Отраженный Градиент, Diamond Gradient - Алмазный Градиент. Заполняет область 

постепенным переходом от одного цвета к другому, т.е. выполняет различные виды 

градиентных заливок. Рисунок заливки определяется выбранным инструментом, его 

цветовая гамма - параметром Gradient, задаваемым в палитре Options (Параметры). 

 
Eyedropper - Пипетка. Позволяет задать основной и фоновый цвета путем взятия проб 

цвета на изображении или из палитр "Синтез" и "Каталог". 

 
Color Sampler - Образец цвета. Отображает цветовые параметры 1-4 цветов 

изображения, выбранных в палитре Info 

 
Paint Bucket - Заливка. Позволяет закрашивать однородные пикселы выделенной 

области изображения выбранным цветом. 

 
Pen - Перо. Используется для рисования контуров с помощью линейных сегментов 

путем создания набора закрепленных точек (узлов). 

 
Direct Selection (Прямое выделение) - Стрелка. Применяется для корректировки 

формы контура путем перемещения узловых точек. 

 

 
Аdd Anchor Point (Добавление узелка контура) - Перо +. Используется для 

добавления новых узловых точек в контур. 

 
Delete Anchor Point - (Удаление узелка контура) - Перо -. Используется для удаления 

узловых точек из контура. 
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Convert Point (Преобразование узелков) - Угол. Используется для изменения свойств 

закрепленных точек (в частности, для превращения их в точки перегиба). 

 
Magnetic Pen - Магнитное перо. Рисует контуры по границам цветовых и тоновых 

переходов. 

 

 

History Brush (Кисть истории) – Выполняет те же функции как Clone Stamp 

(Штамп), им можно рисовать из любого пункта палитры Hystory повторяя 

действия, сохранённые в палитре. 

History (История).  Art History Brush (Художественная кисть истории), взяв за 

основу оригинальное изображение, наносит большое количество мазков.  

 

Healing Brush (Лечащая» кисть) - Копирует новые пиксели, взяв за основу либо 

изображение, либо текстуру. Предварительно необходимо выбрать образец 

изображения, кнопкой Alt+Рабочая кнопка мыши 

Patch (Заплатка) - выделяете необходимый фрагмент и копию фрагмента 

перетягиваете  на новое место. 

 
Freedom Pen (Простая ручка) - Свободное перо. Используется для рисования 

контуров произвольной формы. Рисуют при нажатой кнопке мыши. 

 

Foreground Color, Background Color - Цвета переднего и заднего планов. Для выбора 

цветов планов: цвет переднего плана используется при рисовании и заполнении, 

заднего при стирании фрагмента изображения или как второй цвет при градиентных 

заливках. 

Инструменты для редактирования.  

 Type - Текст. Позволяет создавать битовый текст. 

 
Type Mask (Текстовая маска) - Текст-маска. Используется для создания выделенной 

области в форме символов текста 

 

Vertical Type -Вертикальный текст. Позволяет создавать на изображении 

вертикальный текст - располагает текст по вертикали (с разворотом на 90 гр. и без 

него) 

 Hand - Рука. Перемещает изображение в рабочем окне, не поместившееся на экране. 

 
Zoom - Масштаб. Увеличивает и уменьшает (принажатой клавише Alt) масштаб 

изображения. 

 
Move - Перемещение. Используется для перемещения выделенных областей, слоев и 

направляющих. 

 

Slice (пластина) – Предназначен для разрезания изображения на части. 

Slice Select (выбор пластины) – Предназначен для редактирования разрезанных 

кусков изображения, в этом режиме можно задавать количество разрезаемых кусков. 

Инструменты для ретуширования.  

 

Rubble Stamp - Резиновый штамп. Позволяет воспроизводить точные или 

модифицированные копии элементов изображения и цветовых образцов в том же 

изображении, либо в другом документе. 

 Pattern Stamp - штамп по образцу. Работает в режиме копирования по образцу. 

 

History Brush - Кисть событий Позволяет восстановить первоначальный вид 

фрагмента изображения, обработанного инструментом рисования или 

редактирования. 

 Smudge - Палец. Имитирует эффект размазывания невысохшей краски пальцем. 

 
Blur - Размытие. Позволяет смягчать слишком резкие границы или области в 

изображении, уменьшая контраст между пикселами. 

 
Sharpen - Резкость. Позволяет повышать четкость изображения, делая слишком 

мягкие границы более резкими. 
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Практическая работа - Рамки для изображений 
1. Открываем рисунок, с которым мы будем работать. 

2. Создаем новый канал (как в 4 пункте лаб. раб. "TV развертка"). В результате мы видим просто 

черный фон. Далее выполняем прямоугольное выделение, отступив от краев рисунка примерно на 

1 см.. 

3. Инвертируем выделение командой Select => Inverse и после этого заливаем рамку белым цветом 

командой Edit => Fill, в поле списка Use используем White. 

4. Убираем выделение командой Select => Deselect и для создания рамки применяем фильтр 

командой Filter => Pixelate => Color Halftone (параметры подбирайте по вкусу). 

5. Выполняем пункт 5 лабораторной работы "TV развертка" при этом отключаем флажок invert 

6. Заливаем выделение командой Edit=>Fill, в поле списка Contents выбираем White и убираем 

выделение. 

7. Используя разные фильтры сделайте несколько рамок например: Color Halftone, Sprayed, Strokes 

Ripple 

 
Практическая работа - Рисуем сердце 

1. В новом документе создаем новый слой и делаем по центру выделение в виде ровного круга, 

удерживая для этого при рисовании SHIFT. 

2. Теперь заливаем его «цветом сердца». 

3. Выделяем прямоугольником полкруга, с помощью трансформации получаем полсердца. 

4. Делаем вторую половинку, добавляем световых эффектов, блики, попробуйте разные фильтры. 

5. Нарисуйте ещё 2 сердечка: одно с обводкой, одно сделайте разбитым. 

 
Практическая работа - Практическая работа - Создаем 3D шар 
Создаем новое изображение 400 х400 пикселей. Создаем новый слой. На этом слое делаем выделение 

окружностью инструментом Elliptical Marquee (Выделение эллипса), затем заливаем любым цветом. 

Выделение после заливки не снимаем. 

 

Далее используем эффекты свечения. Filter/Render/Lighting Effects (Фильтр/Освещение/Эффекты свечения). 

Настройки подбираем по вкусу. 
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Теперь, для реалистичности добавим блик на шарик. Filter/Render/Lens Flare (Фильтр/Освещение/Блик). 

 

Отбрасываем тень от шарика - для этого к слою Layer1 применяем эффект Drop Shadow. Снимаем 

выделение Select Deselect  (Выделение/убрать выделение) трехмерный шарик готов. 

 
Практическая работа - Текст в огонь 

1. Создаем новый файл с размером (10-10 cm). Работать необходимо в режиме RGB. На 

нём пишем текст (своё имя), черного цвета. 

2. При использовании инструмента текст, автоматически создается новый 

текстовый слой. 

3. Объединяем оба слоя с помощью меню Layer=>Flatten Image.  

4. Далее применяем фильтр: Filter => Pixelate => Crysrallize. Значение Cell Size 

выбираем по вкусу (5). 

5. Затем изображение делается негативным: Image => Adjust => Invert 

6. Повернем изображение на 90 градусов против часовой стрелки: Image => 

Rotate Canvas => 900 CCW. 

7. Теперь будем делать языки будущего пламени. Для этого применяем 

фильтры: Filter => Stylize => Wind; Filter => Distort => Ripple (Amount - 30) 

конечно, вы можете подобрать настройки по своему вкусу. 

8. Возвращаем изображение в исходное положение: Image - Rotate Canvas - 900 

CW. 

9. Придаем изображению цвет, для этого воспользуемся следующими 

командами: Image => Adjust => Hue/Saturation, обязательно включаем опцию 

Colorize, а значения Hue и Saturation выберите по вкусу, подтверждаем 

настройки. 

 
 

Практическая работа - Текст во льду 
     Повторяем 1-3 пункты лабораторной работы «Огонь» 

1. Применяем фильтр: Filter => Pixelate => Crystallize, Sell Size - по вкусу(5). 

2. Выделяем прямоугольным выделением текст, затем открываем окно диалога 

Color Range  (Select => Color Range) в поле списка Select задаем выделяемый 

цвет, подключаем переключатель Selection и подтверждаем. 

3. Теперь применяем фильтр: Filter => Noise => Add Noise, Amount - 70, 

переключатели Distribution ставим Gaussian. Теперь наш текст нужно размыть 

фильтром: Filter => Blur => Gaussian Blur, Raidus=2. После этого убираем 

выделение: Select => Deselect и применяем фильтр: Filter => Blur => Blur. 

4. Инвертируем изображение: Image => Adjust => Invert. 
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Практическая работа - Плавающие Объекты 
Способ создания в Photoshop изображения объекта плавающего в воде. 

1. Откройте рисунок.  

2.  Инструментом Ручка Pen – P          , обведите 

 контуры объекта. 

3. Сохраните созданный путь, для этого в палитре 

 Пути Paths команда Сохр. путь… Save path…. 

 

 

 

 

4. Преобразуйте путь в выделение Load 

 path as a selection    
5. Скопируйте выделение в буфер обмена. 

6. Создайте новый рисунок с непрозрачным фоном и вставьте 

объект. 

7. Выделите нижнюю половину объекта, вырежьте и, для того, 

чтобы вставить в новый слой в то же место, не отменяя выделения, 

вставьте командой Вставить в (Paste into), задайте прозрачность этого слоя слайдером Непрозрачность 

(Opacity) на палитре слои 40-50. 

8. Преобразуйте выделение в путь кнопкой             Сделать область рабочим путём 

(Make work path from selection) на палитре Пути (Paths). 

9. Создайте новый слой над фоновым, загрузите сохранённый путь как выделение           

, задайте рабочий цвет голубы, примените фильтр Фильтры \Рендер \Облака 

Filter/Render/Clouds, затем выделите эллипс и примените к нему фильтр 

Фильтры\Искажение\ЗигЗаг Filter/Distort/Twirl. 

10. Не отменяя выделения сделайте активным слой с нижней половинкой объекта и 

примените к ней этот же фильтр. 

11. Для реалистичности можно добавить фильтры Фильтр\Искажение\ Волна   

Filter/Distort/Wave Фильтр\Искажение\Океанская дрожь  Filter/Distort/Ocean Ripple. 

12. Слои:     Примерный результат: 

13.  
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Раздел 6. Контроль за изучением дисциплины 

Для контроля успеваемости, после каждого тематического  модуля, студенты 

будут выполнять следующие письменные контрольные работы.  

Модуль I 

1. Векторное и растровое изображения. Недостатки. 

2. Режимы рисования. 

3. Классификация графических пакетов. 

4. Типы компьютерных изображений. 

5. Растровые изображения. 

6. Понятие – разрешение. 

7. Основные параметры изображения. 

Модуль II 

1. Понятие цвета и его характеристики. 

2. Цвет в компьютерной графике. 

3. Цветовые модели и их виды. 

4. Классификация цветовых моделей. 

5. Характеристики света 

6. Способы регулировки цвета. 

7. Образцы фонового и рабочего цветов. 

Модуль III 

 

1. Палитры. 

2. Форматы хранения графической информации. 

3. Растровые графические форматы. 

4. Векторные графические форматы. 

5. Способы соединения фотореалистических изображений. 

6. Принципы работы векторного редактора. 

Модуль IV 

1. Векторные изображения. 

2. Законы смешивания цветов. 

3. Маски 

4. Контуры. Каналы. 

5. Тенденции построения современных графических систем. 

6. Технические средства компьютерной графики. 

Итоговая тестовая работа по дисциплине «Инженерная компьютерная графика»  

1. Пикселизация изображений при увеличении масштаба – один из недостатков 

a. растровой графики 

b. векторной графики 

c. фрактальной графики 

2. Большой размер файла – один из недостатков ... 

a. растровой графики 

b. векторной графики 

c. фрактальной графики 

3. Растровый графический редактор предназначен для ... 

a. построения диаграмм 

b. создания чертежей 
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c. построения графиков 

d. создания и редактирования рисунков 

4. Какой из графических редакторов является растровым? 

a. Adobe Illustrator 

b. Paint 

c. Corel Draw 

d. Xara Xtreme 

5. Разрешение изображения измеряется в ... 

a. пикселях 

b. точках на дюйм (dpi) 

c. мм, см, дюймах 

6. Графика с представлением изображения в виде последовательности точек со 

своими координатами, соединенных между собой кривыми, которые 

описываются математическими уравнениями, называется: 

a. фрактальной 

b. растровой 

c. векторной 

d. прямолинейной 

7. Какие виды компьютерной графики используют в настоящее время? 

a.  Растровая. 

b.  Векторная. 

c.  Фрактальная. 

d.  Акварельная. 

e.  Трёхмерная. 

f.  Маслянная. 

8. Как называют наименьший элемент растровой графики? Запиши ответ одним 

словом латинскими буквами не используя заглавных букв. Данный элемент 

называют - pixel. 

9. Файлы с какой графикой имеют наименьший размер? 

a.  Растровой. 

b.  Векторной. 

c.  Фрактальной. 

d.  Трёхмерной. 

10. Что можно отнести к достоинствам растровой графики по сравнению с 

векторной? 

a. Малый объём графических файлов. 

b. Фотографическое качество изображения. 

c. Возможность просмотра изображения на экране графического дисплея. 

d. Возможность преобразования изображения (поворот, наклон и т.д.). 

e. Возможность масштабирования изображения. 

11. Какое изображение масштабируется без потери качества? 

a. Растровое. 

b. Векторное. 

c. Фрактальное. 

d. Трёхмерное. 

12. Где используется растровое компьютерное изображение? 

a.  Для создания вывесок, этикеток, логотипов, эмблем и пр. 

символьных изображений;  

b. для построения чертежей, диаграмм, графиков, схем; 

c. для рисованных изображений с четкими контурами, не обладающих 

большим спектром оттенков цветов; 
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d.  Для обработки изображений, требующей высокой точности передачи 

оттенков цветов и плавного перетекания полутонов. 

e. В математике; 

f. В архитектуре, в рекламе видеороликах, изделиях машиностроения 

изображения моделируются  и перемещаются в пространстве научные 

расчеты, инженерное проектирование, компьютерное моделирование 

физических объектов. 

13. Где используется векторное компьютерное изображение? 

a.  Для создания вывесок, этикеток, логотипов, эмблем и пр. 

символьных изображений;  

b. для построения чертежей, диаграмм, графиков, схем; 

c. для рисованных изображений с четкими контурами, не обладающих 

большим спектром оттенков цветов; 

d.  Для обработки изображений, требующей высокой точности передачи 

оттенков цветов и плавного перетекания полутонов. 

e. В математике; 

f. В архитектуре, в рекламе видеороликах, изделиях машиностроения 

изображения моделируются  и перемещаются в пространстве научные 

расчеты, инженерное проектирование, компьютерное моделирование 

физических объектов. 

14. К какой компьютерной графике вы отнесёте данное изображение? 

 
a. Растровой. 

b.  Векторной. 

c.  Фрактальной. 

d.  Трёхмерной. 

15. Элементом какой компьютерной графики является данный рисунок? 

 
a. Растровой. 

b.  Векторной. 

c.  Трёхмерной. 

d.  Фрактальной. 

16. Примитивами в графическом редакторе называются:  

a.  линия, круг, прямоугольник  

b.  карандаш, кисть, ластик  

c.  выделение, копирование, вставка  

d.  наборы цветов (палитра) 

17. Для синтеза растровых изображений необходимо задавать: 

a.  разрешение 
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b. размеры изображения. 

c. количество цветов 

d. пропорции 

18. При отображении рисунков на мониторе, используют разрешение: 

a.  от 72 dpi до 120 dpi 

b. от 72 dpi до 300 dpi 

c. от 300 dpi до 600 dpi 

d. от 30 dpi до 120 dpi 

19. Channels (Каналы) Adobe Photoshop используются для хранения: 

a. цветовой информации 

b. масок выделения 

c. изображений  

d. координат изображения 

e. описания рисунка 

20. Контур Adobe Photoshop – это 

a.  вспомогательный векторный объект, который используется для 

выполнения различных операций по обработке растровых изображений. 

b. вспомогательный растровый объект, который используется для 

выполнения различных операций по обработке растровых изображений. 

c. вспомогательный растровый объект, который используется для обводки 

различных объектов. 

21. В цветовой модели RGB установлены следующие параметры:  

0, 255, 0. Какой цвет будет соответствовать этим параметрам? 

a. черный 

b. красный 

c. зеленый 

d. синий 

22. Сколько в ахроматическом цвете цветов: 

a. 256 

b. 2 

c. 16 Bit 

d. 32 Bit 

23. Для характеристики цвета используются следующие атрибуты: 

a. цветовой тон. 

b. яркость. 

c. насыщенность или чистота тона. 

d. значение цвета 

e. прозрачность 

f. источник цвета 

24. Факторы, влияющие на внешний вид конкретного цвета: 

a. источник света; 

b. информация об окружающих предметах; 

c. глаза; 

d. количество цвета 

e. все ответы верны 

25. Цвет в компьютерной графике нужен для того, что бы: 

a. нести в себе определенную информацию об объектах. 

b. различать объекты. 

c. акцентировать внимание на важном – композиционном – центре. 

d. привлекать внимание зрителя. 

e. преобразовать объекты. 

f. сгладить контуры использующихся элементов. 
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26. Глубина цвета называется 

a.  Максимальное количество цветов, которое может быть использовано в 

изображении данного типа. 

b. Количество цвета 

c. Яркость цвета в изображении 

d. Минимальное количество цветов, которое может быть использовано в 

изображении данного типа. 

e.  Все ответы верны 

 

 

Раздел 7. Методические рекомендации по СРС: 

По дисциплине «Инженерная компьютерная графика» разработано методическое 

пособие. «Электронная обучающая система» автор Долгоульский О.В. В данном пособии 

отражены методические рекомендации к самостоятельной работе студентов изучающих 

дисциплины «Инженерная компьютерная графика». 


